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About this book

This book provides information on how to install your DB2® product. It also
introduces DB2 maintenance, administration, and development.

For a complete look at the DB2 documentation library, see the DB2 Information
Center at |http://publib.boulder.ibm.com/infocenter/db2help /|
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Chapter 1. Installation prerequisites

Disk and memory requirements

Disk requirements:

The disk space required for your product depends on the type of installation you
choose and the type of file system you have. The DB2 Setup wizard provides
dynamic size estimates based on the components selected during a typical,
compact, or custom installation.

On Windows®, you might require significantly more space on FAT (File Allocation
Table) drives with large cluster sizes than with NTFS (New Technology File
System) drives.

Remember to include disk space for required software and communication
products.

Memory requirements:

At a minimum, a DB2 database system requires 256 MB of RAM. For a system
running just DB2 and the DB2 GUI tools, a minimum of 512 MB of RAM is
required. However, 1 GB of RAM is recommended for improved performance.
These requirements do not include any additional memory requirements for other
software that is running on your system.

When determining memory requirements, be aware of the following;:

* For DB2 client support, these memory requirements are for a base of five
concurrent client connections. You will need an additional 16 MB of RAM per
five client connections.

* Memory requirements are affected by the size and complexity of your database
system, as well as by the extent of database activity and the number of clients
accessing your system.

In DB2 Version 9, the new self-tuning memory feature simplifies the task of
memory configuration by automatically setting values for several memory
configuration parameters. When enabled, the memory tuner dynamically
distributes available memory resources among several memory consumers
including sort, the package cache, the lock list and buffer pools.

* On Linux', SWAP space at least twice as large as RAM is recommended.

Related concepts:

* “Self tuning memory” in Performance Guide

Getting started with database authorities

Authorities provide a way both to group privileges and to control maintenance
and utility operations for instances, databases, and database objects. Users can
have administrative authorities that give full privileges on a set of database objects,
or they can have system authorities that give full privileges on managing the
system but do not allow access to the data.
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SYSADM is the highest level of administrative authority. It includes all privileges
on databases within the DB2 instance as well as the authority to grant and revoke
all other authorities and privileges.

DBADM provides administrative authority for a specific database. It allows the
user to access and modify all objects within that database. A user with DBADM
authority can grant and revoke privileges on the database but cannot grant or
revoke DBADM authority.

SYSCTRL is the authority for controlling the resources used by the database
manager (for example, creating and deleting databases), but it does not allow
access to the data within the databases.

SYSMAINT is the authority for performing maintenance operations, such as
starting and stopping the DB2 server and backing up and restoring databases. It
does not allow access to the data within the databases.

LOAD authority at the database level, combined with INSERT privilege on a table,
allows the user to load data into that table.

SECADM (security administrator) level applies at the database level and is the
authority required to create, alter and drop security label components, security
policies, and security labels, which are used to protect tables. It is also the
authority required to grant and revoke security labels and exemptions as well as to
grant and revoke the SETSESSIONUSER privilege. A user with the SECADM
authority can transfer the ownership of objects that they do not own. The
SECADM authority has no inherent privilege to access data stored in tables and
has no other additional inherent privilege. It can only be granted by a user with
SYSADM authority. The SECADM authority can be granted to a user but cannot be
granted to a group or to PUBLIC.

Database-specific authorities are stored in the database catalogs; system authorities
are stored in the database manager configuration file for the instance.

You can use the Control Center to grant and revoke database authorities.

Related concepts:

* “Database administration authority (DBADM)” in Administration Guide:
Implementation

* “Extended Windows security using DB2ADMNS and DB2USERS groups” in
Administration Guide: Implementation

* “LOAD authority” in Administration Guide: Implementation

¢ “Security administration authority (SECADM)” in Administration Guide:
Implementation

* “System administration authority (SYSADM)” in Administration Guide:
Implementation

e “System control authority (SYSCTRL)” in Administration Guide: Implementation

* “System maintenance authority (SYSMAINT)” in Administration Guide:
Implementation
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Windows installation prerequisites

Installation requirements for DB2 clients and servers

(Windows)

For the most up-to-date prerequisite information, see

. |www.ibm.com/ software/data/db2/udb/ sysreqs.htmll

To install a DB2 client or server product, the following operating system, software,
and hardware prerequisites must be met:

Table 1. Windows installation prerequisites

Operating System

Service Pack

Hardware

Windows XP Professional
(32-bit)

Windows XP Professional x64

Service Pack 2 or
later

All Intel® and AMD processors
capable of running the
supported Windows operating
systems (32-bit and 64-bit)

Windows 2003 Standard Edition
(32-bit and 64-bit)

Windows 2003 Advanced Edition
(32-bit and 64-bit)

Windows 2003 Datacenter
Edition (32-bit and 64-bit)

Service Pack 1 or
later

Additional client considerations

DB2 products continue to be supported on Windows 98, Windows ME,
Windows NT®, and Windows 2000 until DB2 Universal Database Version
8.1 goes out of service. For existing installations and new installations of
DB2 products, upgrading to a more current operating system version of
Windows (such as Windows 2003) is recommended. Version 9 clients
cannot be installed on Windows 98, Windows ME, or Windows NT Server
4 operating systems. If you wish to continue running DB2 products on
back level releases of Windows, you require the following maintenance

levels:

* Windows NT Version 4 with Service Pack 6a or later
* Windows 2000 with Service Pack 4 or later
¢ Internet Explorer 4.01 Service Pack 2

Windows XP Service Pack 1 is required for running DB2 applications in
either of the following environments:

* Applications that have COM+ objects using ODBC; or

* Applications that use OLE DB Provider for ODBC with OLE DB
resource pooling disabled

If you are unsure about whether your application environment qualifies,
then it is recommended that you install the appropriate Windows service
level.

For more information about this COM+ issue, see the following Microsoft®
Knowledge Base article:

* http://support.microsoft.com/default.aspx?scid=KB;EN-US;306414
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Additional software considerations

* MDAC 2.8 is required. The DB2 Setup wizard will install MDAC 2.8 if it
is not already installed.

Note: If a previous version of MDAC (for example, 2.7) is already
installed, DB2 install will upgrade MDAC to 2.8. For a typical
install, MDAC 2.8 is installed. For a compact install, MDAC 2.8 is
not installed. For a custom install, MDAC 2.8 is installed but only
if you have not deselected the default which is to install it. If you
deselect MDAC as part of a custom install, it will not be installed.

* If you plan to use LDAP (Lightweight Directory Access Protocol), you
should use either a Microsoft LDAP client or the IBM® Tivoli® Directory
Server v6 client (also known as the IBM LDAP client which is included
with DB2). Prior to installation of the Microsoft Active Directory, you
will need to extend your directory schema using the db2schex utility,
which can be found on the installation media.

The Microsoft LDAP client is included with the operating system for
Windows XP, and Windows Server 2003.

* If you plan to use the Tivoli Storage Manager facilities for the backup
and restoration of your databases, you need the Tivoli Storage Manager
Client Version 4.2.0 or later.

— For Windows 64-bit operating systems, you require the TSM client
API Version 5.1.

* If you have the IBM Antivirus program installed on your operating
system, it must be disabled or uninstalled to complete a DB2 installation.

* TCP/IP support must be enabled to view online help.

* One of the following browsers is required to view online help, run the
DB2 install launchpad (setup.exe), and to run First Steps (db2fs):

— Internet Explorer 5.5 and up
— Mozilla 1.4 and up

- Firefox 1.0 and up

— Netscape 7.0 and up

Related concepts:
* “Support changes for 32-bit and 64-bit DB2 servers” in Migration Guide

Related tasks:

* “An overview of installing your DB2 product (Windows)” in Quick Beginnings for
DB2 Servers

Related reference:

* “IBM Software Development Kit for Java levels for DB2 products” in Quick
Beginnings for DB2 Servers

¢ “Communication protocols supported” in Quick Beginnings for DB2 Clients

Security issues when installing the DB2 database manager

Security considerations are important to the DB2 administrator from the moment
the product is installed.

To complete the installation of the DB2 database manager, a user ID, a group
name, and a password are required. The GUI-based DB2 database manager install
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program creates default values for different user IDs and the group. Different
defaults are created, depending on whether you are installing on UNIX® or
Windows platforms:

* On UNIX and Linux platforms, if you choose to create a DB2 instance in the
instance setup window, the DB2 database install program creates, by default,
different users for the DAS (dasusr), the instance owner (db2inst), and the
fenced user (db2fenc). Optionally, you can specify different user names

The DB2 database install program appends a number from 1-99 to the default
user name, until a user ID that does not already exist can be created. For
example, if the users db2instl and db2inst2 already exist, the DB2 database
install program creates the user db2inst3. If a number greater than 10 is used,
the character portion of the name is truncated in the default user ID. For
example, if the user ID db2fenc9 already exists, the DB2 database install
program truncates the ¢ in the user ID, then appends the 10 (db2fen10).
Truncation does not occur when the numeric value is appended to the default
DAS user (for example, dasusr24).

* On Windows platforms, the DB2 database install program creates, by default, the
user db2admin for the DAS user, the instance owner, and fenced users (you can
specify a different user name during setup, if you want). Unlike UNIX
platforms, no numeric value is appended to the user ID.

To minimize the risk of a user other than the administrator from learning of the
defaults and using them in an improper fashion within databases and instances,
change the defaults during the install to a new or existing user ID of your choice.

Note: Response file installations do not use default values for user IDs or group
names. These values must be specified in the response file.

Passwords are very important when authenticating users. If no authentication
requirements are set at the operating system level and the database is using the
operating system to authenticate users, users will be allowed to connect. For
example on UNIX operating systems, undefined passwords are treated as NULL.
In this situation, any user without a defined password will be considered to have a
NULL password. From the operating system’s perspective, this is a match and the
user is validated and able to connect to the database. Use passwords at the
operating system level if you want the operating system to do the authentication of
users for your database.

When working with DB2 Data Partitioning Feature (DPF) on UNIX operating
system environments, the DB2 database manager by default uses the rsh utility to
run some commands on remote nodes. The rsh utility transmits passwords in clear
text over the network, which can be a security exposure if the DB2 server is not on
a secure network. You can use the DB2RSHCMD registry variable to set the remote
shell program to a more secure alternative that avoids this exposure. One example
of a more secure alternative is ssh. See the DB2RSHCMD registry variable
documentation for restrictions on remote shell configurations.

After installing the DB2 database manager, also review, and change (if required),
the default privileges that have been granted to users. By default, the installation
process grants system administration (SYSADM) privileges to the following users
on each operating system:

Windows environments A valid DB2 database user name that belongs to
the Administrators group.
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UNIX platforms A valid DB2 database user name that belongs to
the primary group of the instance owner.

SYSADM privileges are the most powerful set of privileges available within the
DB2 database manager. As a result, you might not want all of these users to have
SYSADM privileges by default. The DB2 database manager provides the
administrator with the ability to grant and revoke privileges to groups and
individual user IDs.

By updating the database manager configuration parameter sysadm_group, the
administrator can control which group of users possesses SYSADM privileges. You
must follow the guidelines below to complete the security requirements for both
the DB2 database installation and the subsequent instance and database creation.

Any group defined as the system administration group (by updating sysadm_group)
must exist. The name of this group should allow for easy identification as the
group created for instance owners. User IDs and groups that belong to this group
have system administrator authority for their respective instances.

The administrator should consider creating an instance owner user ID that is easily
recognized as being associated with a particular instance. This user ID should have
as one of its groups the name of the SYSADM group created above. Another
recommendation is to use this instance-owner user ID only as a member of the
instance owner group and not to use it in any other group. This should control the
proliferation of user IDs and groups that can modify the instance, or any object
within the instance.

The created user ID must be associated with a password to provide authentication
before being permitted entry into the data and databases within the instance. The
recommendation when creating a password is to follow your organization’s
password naming guidelines.

Note: To avoid accidentally deleting or overwriting instance configuration or other
files, administrators should consider using another user account, which does
not belong to the same primary group as the instance owner, for day-to-day
administration tasks that are performed on the server directly.

Related concepts:

* “General naming rules” in Administration Guide: Implementation

e “User, user ID and group naming rules” in Administration Guide: Implementation
* “Authentication” in Administration Guide: Planning

* “Authorization” in Administration Guide: Planning

* “Naming rules in a Unicode environment” in Administration Guide:
Implementation

* “Naming rules in an NLS environment” in Administration Guide: Implementation
* “Location of the instance directory” in Administration Guide: Implementation

* “UNIX platform security considerations for users” in Administration Guide:
Implementation

* “Windows platform security considerations for users” in Administration Guide:
Implementation

Related reference:

* “Communications variables” in Performance Guide
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Granting user rights (Windows)

This topic describes the steps required to grant user rights on Windows operating
systems. Specific user rights are recommended for user accounts required to install
and set up DB2.

Prerequisites:

To grant advanced user rights on Windows you must be logged on as a local
Administrator.

Procedure:
1. Click Start and select Run ....

2. Type secpol.msc and click OK.

3. Select Local Security Policy.

4. In the left window pane, expand the Local Policies object, then select User
Rights Assignment.

5. In the right window pane, select the user right that you want to assign.

6. From the menu, select Action —> Security...

7. Click Add, then select a user or group to assign the right to, and click Add.

8. Click OK.

If your computer belongs to a Windows 2000 or Windows Server 2003 domain, the
domain user rights may override your local settings. In this case, your Network
Administrator will have to make the changes to the user rights.

Related concepts:
e “User, user ID and group naming rules” in Administration Guide: Implementation

Related reference:

* “Required user accounts for installation of DB2 server products (Windows)” in
Quick Beginnings for DB2 Servers

DB2 system administrator group considerations (Windows)

By default, system administrative (SYSADM) authority is granted to any valid DB2
user account that belongs to the Administrators group on the computer where the
account is defined. If the account is a local account, then it must belong to the local
Administrators group. If the account is a domain account, then it must belong to
the Administrators group at the domain controller or the local Administrators

group.

For example, if a user logs on to a domain account and tries to access a DB2
database, the DB2 database server goes to a domain controller to enumerate
groups (including the Administrators group). You can force the DB2 database
server to always perform group lookup on the local computer by setting the
registry variable DB2_GRP_LOOKUP=local and adding the domain accounts (or
global groups) to the local group.

For a domain user to have SYSADM authority, they must belong to the local

Administrators group or the Administrators group at the domain controller. Since
the DB2 database server always performs authorization at the machine where the
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account is defined, adding a domain user to the local Administrators group on the
server does not grant the domain user SYSADM authority to this group.

To avoid adding a domain user to the Administrators group at the domain
controller, create a global group and add the domain users to which you want to
grant SYSADM authority to it. Then update the DB2 configuration parameter
SYSADM_GROUP with the name of the global group.

To update the DB2 configuration parameter, enter the following commands:

db2 update dbm cfg using sysadm_group global_group
db2stop
db2start

Related concepts:

* “System administration authority (SYSADM)” in Administration Guide:
Implementation

Related reference:

* “sysadm_group - System administration authority group name configuration
parameter” in Performance Guide

Extending the directory schema (Windows)

If you plan to use the Lightweight Directory Access Protocol (LDAP) directory
server feature with Windows 2000 or Windows Server 2003, you should extend the
Active Directory schema to contain DB2 object classes and attribute definitions.
You should perform this task before you install any DB2 products.

Extending the directory schema ensures that:

* The default DB2 instance, created during the installation, is cataloged as a DB2
node in Active Directory provided the installation user ID had sufficient
privileges to write to Active Directory.

* Any databases that the user creates after installation will automatically be
cataloged into Active Directory.

If you decide to install your DB2 product and create databases before you extend
the directory schema, you will have to manually register the node and catalog the
databases.

Prerequisites:

Your Windows user account must have Schema Administration authority.

Procedure:

To extend the directory schema:
1. Log onto the domain controller.

2. Run the db2schex.exe program from the installation CD with a user account
that has Schema Administration authority. You can run this program without
logging off and logging on again, as follows:

runas /user:MyDomain\Administrator x:\db2\Windows\utilities\db2schex.exe

where x: represents the CD drive letter.
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When db2schex.exe completes, you can proceed with the installation of your
DB2 product.

Related reference:

+ |“Installation requirements for DB2 clients and servers (Windows)” on page 5|
* “CATALOG LDAP DATABASE command” in Command Reference
e “REGISTER command” in Command Reference

Linux installation prerequisites

Installation requirements for DB2 clients and servers (Linux)

For the most up-to-date prerequisite information, see |http:/ /www.ibm.com /|
[software/data/db2/udb/sysregs.htmi]

For the latest information on supported Linux distributions, point your browser to
http:/ /www.ibm.com/db2/linux/validate.

The supported operating systems for Linux include:
* Red Hat Enterprise Linux 4 (RHEL4) Update 2
e SUSE Linux Enterprise Server 9 (SLES9) Service Pack 2

To install a DB2 client or server product, the following distribution requirements,
hardware, and communications prerequisites must be met:

Table 2. Linux prerequisites

Distribution Requirements Hardware

You should update your kernel configuration parameters | DB2 server products are supported on:

in preparation for your Linux distribution. The default « x86 (Intel Pentium®, Intel Xeon®, and AMD Athlon)
values for particular kernel parameters are not sufficient
when running a DB2 database system.

You may also have other products or applications that - POWER" (any iSeries™ or pSeries® that support Linux)
require Linux system resources. You should set the

kernel configuration parameters based on the needs of

your Linux system working environment. — The Database Partitioning Feature (DPF) is not
supported.
The kernel configuration parameters are set in + (Client only)64-bit zSeries or System 29" boxes.

/etc/sysctl.conf. See the Modifying kernel parameters
(Linux) section of the DB2 Information Center.

Refer to your operating system manual for information
on setting and activating these parameters using the

sysctl command.

* x86-64 (Intel EM64T and AMD64)
* 1A64 (Intel Itanium® 2 or higher)

* (Server only)eServer zSeries®.

Package requirements (server only):

The following tables list the package requirements for SUSE Linux and Red Hat
distributions for DB2 Version 9 partitioned servers.

¢ The pdksh Korn Shell package is required for all DB2 systems.

* A remote shell utility is required for partitioned database systems. DB2 supports
the following remote shell utilities:

— rsh
— ssh

Chapter 1. Installation prerequisites 11


http://www.ibm.com/software/data/db2/udb/sysreqs.html
http://www.ibm.com/software/data/db2/udb/sysreqs.html

By default, DB2 uses rsh when executing commands on remote DB2 nodes, for
example, when starting a remote DB2 database partition. To use the DB2 default,
the rsh-server package must be installed (see table below). For a comparison
between rsh and ssh, see the “Security issues when installing DB2” section of the
Administration Guide: Implementation.

If you choose to use the rsh remote shell utility, inetd (or xinetd) must be
installed and running as well. If you choose to use the ssh remote shell utility,
you need to set the DB2RSHCMD registry variable immediately after the DB2
installation is complete. If this registry variable is not set, rsh is used. For more
information on the DB2RSHCMD registry variable, see the Performance Guide
book.

* The nfs-utils Network File System support package is required for partitioned
database systems.

All required packages should be installed and configured before continuing with
the DB2 setup. For general Linux information, see your Linux distribution
documentation.

Package requirements for SUSE Linux

Package name Description

pdksh Korn Shell. This package is required for partitioned database
environments.

openssh This package contains a set of server programs which allow

users to run commands on (and from) remote computers via a
secure shell. This package is not required if you use the default
configuration of DB2 with rsh.

rsh-server This package contains a set of server programs which allow
users to run commands on remote computers, login in to other
computers, and copy files between computers (rsh, rexec, rlogin,
and rcp). This package is not required if you configure DB2 to
use ssh.

nfs-utils Network File System support package. It allows access to local
files from remote computers.

Package requirements for Red Hat

Directory Package name Description

/System Environment/Shell | pdksh Korn Shell. This package is required for
partitioned database environments.

/Applications/Internet openssh This package contains a set of client
programs which allow users to run
commands on a remote computer via a
secure shell. This package is not
required if you use the default
configuration of DB2 with rsh.

/System Environment/ openssh-server This package contains a set of server
Daemons programs which allow users to run
commands from a remote computer via
a secure shell. This package is not
required if you use the default
configuration of DB2 with rsh.
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Package requirements for Red Hat

Directory Package name Description
/System Environment/ rsh-server This package contains a set of programs
Daemons which allow users to run commands on

a remote computer. Required for
partitioned database environments. This
package is not required if you configure
DB2 to use ssh.

/System Environment/ nfs-utils Network File System support package.
Daemons It allows access to local files from
remote computers.

Software considerations:
* One of the following browsers is required to view online help and to run First
Steps (db2fs):
— Mozilla 1.4 and up
— Firefox 1.0 and up
— Netscape 7.0 and up

¢ An X Window System software capable of rendering a graphical user interface is
required if you want to use the DB2 Setup wizard to install DB2 or if you want
to use any DB2 graphical tools. (Available only on Linux for x86 and Linux on
AMD 64/EM64T.)

DB2 product installation on NFS (Network File System):

The installation of DB2 products on NFS (Network File System) is not
recommended. Running DB2 products on NFS (for example, NFS mounting
/opt/IBM/db2/V9.1 and then running off code that was physically installed on a
remote system) requires several manual setup steps. There are also a number of
potential issues with setting up NFS for DB2. These include possible problems that
involve:

¢ Performance (impacted by network performance)

* Availability (you are allowing a single point of failure)
* Licensing (there is no checking done across machines)
* Diagnosing NFS errors can be difficult

As mentioned, the setup for NFS will require several manual actions including:
* Ensuring that the mount point preserve the install path

* Permission must be controlled (for example, write permission should not be
given to the mounting machine)

* DB2 registries have to be set up manually and maintained across all mounting
machines

* The list installed DB2 products and features command (db2ls) must be set up
and maintained properly if you need to detect DB2 products and features

* More care is required when updating your DB2 product environment

* More steps are required when cleaning up on the exporting machine and the
mounting machine

For detailed instructions, look for the “Setting Up DB2 on NFS Mounted File
System” white paper which will be available soon after DB2 Version 9 is made
available.
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Related concepts:

* |“Security issues when installing the DB2 database manager” on page 6|

Related tasks:
* “Modifying kernel parameters (Linux)” in Quick Beginnings for DB2 Servers

* “Preparing to install DB2 for Linux on zSeries” in Quick Beginnings for DB2
Servers

Related reference:
¢ “Communication protocols supported” in Quick Beginnings for DB2 Clients

¢ “IBM Software Development Kit for Java levels for DB2 products” in Quick
Beginnings for DB2 Servers

* “Communications variables” in Performance Guide

Centralized user-management considerations (Linux)

In environments that include security software, such as NIS (Network Information
Services) or NIS+, there are some installation considerations. The DB2 installation
scripts attempt to update objects that are under the control of the security
packages, such as users and groups, and will not be able to do so if NIS or NIS+ is
being used for user management.

At instance creation, without a security component present, instance owner’s group
list is modified to include that of the database administrative server (DAS) user’s
primary group, if the DAS is created. If the instance creation program is unable to
modify these properties (it will not if NIS/NIS+ is controlling the group), it reports
that it could not. The warning message provides the necessary information to
manually make the changes.

These considerations hold true for any environment in which an external security
program does not allow the DB2 installation or instance creation programs to
modify user characteristics.

If the DB2 Setup wizard detects NIS on your computer, you are not given the
option of creating new users during the installation. Instead, you must choose
existing users.

Consider the following restrictions if you are using NIS or NIS+:

* Groups and users must be created on the NIS server before running the DB2
Setup wizard.

* Secondary groups must be created for the DB2 instance owner and the DB2
Administration Server on the NIS server. You must then add the primary group
of the instance owner to the secondary DB2 Administration Server group.
Likewise, you must add the primary DB2 Administration Server group to the
secondary group for the instance owner.

* On a partitioned DB2 database system, before you create an instance, there must
be an entry for the instance in the etc/services file. For example, if you want to
create an instance for the user db2instl, you require an entry similar to the
following:

DB2_db2instl  50000/tcp

Related tasks:
+ |“Installing DB2 servers (Linux)” on page 19|
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Related reference:

* “Installation requirements for DB2 clients and servers (AIX)” in Quick Beginnings
for DB2 Servers

* “Installation requirements for DB2 clients and servers (HP-UX)” in Quick
Beginnings for DB2 Servers

+ |“Installation requirements for DB2 clients and servers (Linux)” on page 11

* “Installation requirements for DB2 clients and servers (Solaris Operating
System)” in Quick Beginnings for DB2 Servers
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Chapter 2. Installation

Installing DB2 servers (Windows)

This task describes how to start the DB2 Setup wizard on Windows. You will use
the DB2 Setup wizard to define your installation and install your DB2 product on
your system.

Prerequisites:

Before you start the DB2 Setup wizard:

* If you are planning on setting up a partitioned database environment, see the
"Setting up a partitioned database environment" topic.

* Ensure that your system meets installation, memory, and disk requirements.

* If you are planning to use LDAP on Windows 2000 or Windows Server 2003 to

register the DB2 server in Active Directory, you should extend the directory
schema before you install.

* You must have a local Administrator user account with the recommended user
rights to perform the installation.

¢ Although not mandatory, it is recommended that you close all programs so that
the installation program can update any files on the computer without requiring
a reboot.

Restrictions:

* The DB2 copy name and the instance name cannot start with a numeric value.

* The DB2 copy name and the instance name must be unique among all DB2
copies.

* The use of XML features is restricted to a database that is defined with the code
set UTF-8 and that has only one database partition.

Procedure:

To start the DB2 Setup wizard:

1. Log on to the system with the local Administrator account that you have
defined for the DB2 installation.

2. Insert your DB2 product CD into the drive. If enabled, the auto-run feature
automatically starts the DB2 Setup launchpad. If the auto-run does not work,
use Windows Explorer to browse the DB2 product CD and double-click on the
setup icon.

3. From the DB2 Setup launchpad, you can view installation prerequisites and the
release notes, or you can proceed directly to the installation. You may want to
review the installation prerequisites and release notes for late-breaking
information.

4. Click Install a Product and the Install a Product window will display the
products available for installation.

If you have no existing DB2 products installed on your computer, launch the
installation by clicking Install New. Proceed through the installation following
the DB2 Setup wizard's prompts.
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If you have at least one existing DB2 product installed on your computer, you
can:

* Click Install New to create a newDB2 copy

* Click Work with Existing to upgrade an existing DB2 copy, to add
functionality to an existing DB2 copy, or to install an add-on product.

¢ Click Migrate to migrate an existing DB2 Version 8 copy.

5. The DB2 Setup wizard will determine the system language, and launch the
setup program for that language. Online help is available to guide you through
the remaining steps. To invoke the online help, click Help or press F1. You can
click Cancel at any time to end the installation.

Your DB2 product will be installed, by default, in the x:\Program
Files\IBM\sql1ib directory, where x: represent the drive letter of the drive where
you have installed your DB2 product.

If you are installing on a system where this directory is already being used, the
DB2 product installation path will have _xx added to it, where _xx are digits,
starting at 01 and increasing depending on how many DB2 copies you have
installed.

You can also specify your own DB2 product installation path.

For information on errors encountered during installation, review the installation
log file located in the My Documents\DB2LOG\ directory. The log file uses the
following format: DB2-ProductAbrrev-DateTime.log, for example, DB2-ESE-Tue Apr
04 17_04_45 2006.70g.

If you want your DB2 product to have access to DB2 documentation either on your
local computer or on another computer on your network, then you must install the
DB2 Information Center. TheDB2 Information Center contains documentation for
the DB2 database system and DB2 related products. By default, DB2 information
will be accessed from the web if the DB2 Information Center is not locally
installed.

DB2 Express memory limits and the DATABASE_MEMORY configuration parameter:

If you are installing DB2 Express Edition or DB2 Express-C Edition on a system
that has more memory than the maximum memory limit of 4GB, as outlined in the
terms and conditions of the product, you need to explicitly set the DATABASE_MEMORY
configuration parameter to 4GB or less, so that the Self Tuning Memory Manager
will work within your licensed memory limits.

Note: If you have more than one database on that server, the sum of all database
memory usage cannot exceed 4GB.

You can use the Control Center or the UPDATE DATABASE CONFIGURATION
command to make this change. For example, to set the DATABASE_MEMORY limit to
4GB, enter the following command:

DB2 UPDATE DATABASE CONFIGURATION using DATABASE_MEMORY 1000000 IMMEDIATE;
CONNECT RESET;

Also, when using the Configuration Advisor to assist you in configuring the
performance of your database, you need to set the Target Memory on the Server
page to a percentage of your total system memory that will ensure you stay under
the 4GB memory limit.
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Related concepts:

* “About the Release Notes” in Release notes

* “DB2 database object naming rules” in Administration Guide: Implementation

* “DB2 Information Center installation options” in Quick Beginnings for DB2 Servers

Related tasks:

¢ “Notification and contact list setup and configuration” in Administration Guide:
Implementation

* “Tools catalog database and DB2 administration server (DAS) scheduler setup
and configuration” in Administration Guide: Implementation

* “Migrating a DB2 server (Windows)” in Migration Guide

* “Setting up a partitioned database environment” in Quick Beginnings for DB2
Servers

* “Using the Default DB2 Selection wizard (Windows)” in Quick Beginnings for
DB2 Servers

Related reference:
* “UPDATE ADMIN CONFIGURATION command” in Command Reference
“Multiple DB2 copies roadmap” in Administration Guide: Implementation

[‘Disk and memory requirements” on page 3|

[“Installation requirements for DB2 clients and servers (Windows)” on page 5|

+ |“Language identifiers for running the DB2 Setup wizard in another language”]

on page 6Z|

Installing DB2 servers (Linux)

This task describes how to start the DB2 Setup wizard on Linux systems. The DB2
Setup wizard is used to define your installation preferences and to install your
DB2 product on your system.

Prerequisites:

Before you start the DB2 Setup wizard:

* Ensure that your system meets installation, memory, and disk requirements.
* You must have root authority to perform the installation.

¢ The DB2 product image must be available.

* The DB2 Setup wizard is a graphical installer. You must have X windows
software capable of rendering a graphical user interface for the DB2 Setup
wizard to run on your machine. Ensure that the X windows server is running.
Ensure that you have properly exported your display. For example, export
DISPLAY=9.26.163.144:0.

 If NIS/NIS+ or similar security software is used in your environment, you must
manually create required DB2 users before you start the DB2 Setup wizard.
Refer to the referenced Centralized user-management considerations topic before
you begin.

Restrictions:

The use of XML features is restricted to a database that is defined with the code set
UTF-8 and has only one database partition.
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Procedure:

To start the DB2 Setup wizard:
1. Log on to the system as a user with root authority.

2. Change to the directory where the DB2 product CD is mounted by entering the
following command:

cd /cdrom

where /cdrom represents mount point of the DB2 product CD.

3. If you downloaded the DB2 product image, you must decompress and untar
the product file.

a. Decompress the product file:
gzip -d product.tar.gz

where product is the name of the product that you downloaded.
b. Untar the product file:
tar -xvf product.tar
c. Change directory:
cd ./product/diskl
4. Enter the ./db2setup command from the directory where the product image
resides to start the DB2 Setup wizard.

5. The IBM DB2 Setup Launchpad opens. From this window, you can view
installation prerequisites and the release notes, or you can proceed directly to
the installation. You may want to review the installation prerequisites and
release notes for late-breaking information.

6. Click Install a Product and the Install a Product window will display the
products available for installation.

Launch the installation by clicking Install New. Proceed through the
installation following the DB2 Setup wizard's prompts.

Once you have initiated the installation, proceed through the DB2 Setup wizard
installation panels and make your selections. Installation help is available to
guide you through the remaining steps. To invoke the installation help, click
Help or press F1. You can click Cancel at any time to end the installation.

Your DB2 product will be installed, by default, in the following directory:
Linux /opt/ibm/db2/V9.1

If you are installing on a system where this directory is already being used, the
DB2 product installation path will have _xx added to it, where _xx are digits,
starting at 01 and increasing depending on how many DB2 copies you have
installed.

You can also specify your own DB2 product installation path.

The installation logs, db2setup.log and db2setup.err will be located, by default, in
the /tmp directory. You can specify the location of the log files.

The db2setup.log file captures all DB2 installation information including errors.
The db2setup.err file captures any error output that is returned by Java = (for

example, exceptions and trap information).

There is no longer a db2setup.his file. Instead, the DB2 installer saves a copy of
the db2setup.log file in the DB2_DIR/install/logs/ directory, and renames it
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db2install.history. If the name already exists, then the DB2 installer renames it
db2install.history.xxxx, where xxxx is 0000-9999, depending on the number of
installations you have on that machine.

Each installation copy has a separate list of history files. If an installation copy is
removed, the history files under this install path will be removed as well. This
copying action is done near the end of the installation and if the program is
stopped or aborted before completion, then the history file will not be created.

On Linux 32-bit, if you want your DB2 product to have access to DB2
documentation either on your local computer or on another computer on your
network, then you must install the DB2 Information Center. The DB2 Information
Center contains documentation for the DB2 database system and DB2 related
products.

DB2 Express memory limits and the DATABASE_MEMORY configuration parameter:

If you are installing DB2 Express Edition or DB2 Express-C Edition on a system
that has more memory than the maximum memory limit of 4GB, as outlined in the
terms and conditions of the product, you need to explicitly set the DATABASE_MEMORY
configuration parameter to 4GB or less, so that the Self Tuning Memory Manager
will work within your licensed memory limits.

Note: If you have more than one database on that server, the sum of all database
memory usage cannot exceed 4GB.

You can use the Control Center or the UPDATE DATABASE CONFIGURATION
command to make this change. For example, to set the DATABASE_MEMORY limit to
4GB, enter the following command:

DB2 UPDATE DATABASE CONFIGURATION using DATABASE_MEMORY 1000000 IMMEDIATE;
CONNECT RESET;

Also, when using the Configuration Advisor to assist you in configuring the
performance of your database, you need to set the Target Memory on the Server
page to a percentage of your total system memory that will ensure you stay under
the 4GB memory limit.

Related concepts:
* “DB2 Information Center installation options” in Quick Beginnings for DB2 Servers
* “DB2 database object naming rules” in Administration Guide: Implementation

Related tasks:

* “Notification and contact list setup and configuration” in Administration Guide:
Implementation

* “Tools catalog database and DB2 administration server (DAS) scheduler setup
and configuration” in Administration Guide: Implementation

* “Migrating a DB2 server (Linux and UNIX)” in Migration Guide

Related reference:

* |“Centralized user-management considerations (Linux)” on page 14|
« “UPDATE ADMIN CONFIGURATION command” in Command Reference

* “Multiple DB2 copies roadmap” in Administration Guide: Implementation
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Chapter 3. Verifying your installation

Verifying the installation of DB2 servers using First Steps (Linux and

Windows)

You should verify that the DB2 server installation has completed successfully by
accessing data from the SAMPLE database.

Prerequisites:

You must have the Control Center and the First Steps component installed to
perform this task.

First Steps is listed as a getting started component in the feature selection
window in the DB2 Setup wizard. It is installed as part of a Typical installation
or may be selected when performing a Custom installation.

The Control Center component is only available on Linux (x86 and
AMD64/EM64T only) and Windows.

Procedure:

1.
2.

On Linux, log on to the system as the instance owner.

On Windows, click Start and, select Programs -> IBM DB2 -> [DB2 Copy Name]
-> Set-up Tools > First Steps. On Linux and Windows, you can start First Steps
by typing the db2fs command.

Select Database Creation in the First Steps launchpad. On the Database
Creation page, you will see links to the DB2 Information Center for creating the
SAMPLE database and the Create SAMPLE Database button. Click Create
SAMPLE Database to launch the Create SAMPLE Databases window.

You have the options to choose the type of database objects to create and the
database location. You can choose the drive on which to create the SAMPLE
database on Windows, and the directory on which to create the SAMPLE
database on Linux.

This command may take a few minutes to process. When the SAMPLE database
has been created, you will receive a completion message. Click OK.

Launch the Control Center. On Windows, click Start and, select Programs ->
IBM DB2 -> [DB2 Copy Name] -> General Administration Tools —> Control
Center.. On Linux systems, type the db2cc command

In the left pane of the Control Center screen, expand the object tree to view the
SAMPLE database and SAMPLE database objects. Select the Tables object to view
the SAMPLE database tables in the right pane of the Control Center screen.
Right-click on the table name staff and select Query. In the command editor
window, click the run button to execute the query and see the result set.

After you have verified the installation, you can remove the SAMPLE database to
free up disk space. However, you will need to keep the sample database if you
plan to make use of the sample applications.

Enter the db2 drop database sample command to drop the SAMPLE database.

Related tasks:
* [“Verifying the installation using the command line processor (CLP)” on page 24|
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Related reference:

* “db2fs - First steps command” in Command Reference

Verifying the installation using the command line processor (CLP)

You can verify the installation by creating a sample database and running SQL
commands to retrieve sample data.

Prerequisites:

* The sample database component, found in the features selection, must be
installed on your system and is included in a typical installation.

* You require a user with SYSADM authority.
Procedure:

To verify the installation:

1. Log on to the system as a user with SYSADM authority.

2. Start the database manager by entering the db2start command.

3. Enter the db2sampl command to create the SAMPLE database.
This command may take a few minutes to process. There is no completion
message; when the command prompt returns, the process is complete.

The SAMPLE database is automatically cataloged with the database alias SAMPLE
when it is created.

4. Connect to the SAMPLE database, retrieve a list of all the employees that work in
department 20, and reset the database connection. Enter the following
commands from the command line processor (CLP):

connect to sample

"select * from staff where dept = 20"
connect reset

After you have verified the installation, you can remove the SAMPLE database to
free up disk space. Enter the db2 drop database sample command to drop the
SAMPLE database.

Related tasks:

* |“Verifying the installation of DB2 servers using First Steps (Linux and|
Windows)” on page 23]
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Chapter 4. DB2 product licensing

DB2 product license files

Each DB2 product and feature has a license file associated with it. The license file
is found on the associated activation CD supplied as a part of the product media.
You should register the license file before using the DB2 product.

The management of licenses for DB2 products or features is done through the
License Center within the Control Center, or, through the db2licm License
Management Tool command.

To assist you in managing your licenses, a compliance report lists the compliance
or noncompliance of DB2 features with your current product entitlement.

If you installed a DB2 product with a try and buy license and now want to
upgrade to a full license, you do not need to reinstall the DB2 product. You simply
upgrade your license. This is also true for upgrading from one license type to
another, for example upgrading from a User license to a CPU license. For details
see Upgrading your DB2 license.

Related concepts:
* “License Center overview” in Administration Guide: Implementation
* “DB2 installation methods” in Quick Beginnings for DB2 Servers

Related tasks:
+ [“Checking DB2 license compliance” on page 26|

* “Registering a DB2 product or feature license key using the db2licm command”
in Installation and Configuration Supplement

+ |“Registering a DB2 product or feature license key using the License Center” on|

page 25|

+ [“Upgrading a Try and Buy license” on page 27|

Related reference:

¢ “db2licm - License management tool command” in Command Reference

Registering a DB2 product or feature license key using the License
Center

You should register a DB2 product or feature license key where the DB2 product or
feature is installed. For more information on these product options, see the
[Version 9 packaging| information on the web.

If you want the product or feature license key added automatically during the
installation, you need to copy the license key to the /db2/1icense directory of the
installation image before launching the DB2 Setup wizard.

Procedure:

To register a DB2 license key:
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1. Start the DB2 Control Center and select License Center from the Tools menu.

2. Select the system for which you are installing a license. Select the instance on
your systems. Select the product from installed products. The Installed
Products field will display the name of the product that you have installed.

3. Select Add from the License menu.

4. In the Add License window, select the license file:
¢ On Windows servers: x:\db2\1icense\license_filename.lic
* On Linux or UNIX servers: /cd/db2/1icense/license_filename.lic
where x: or /cd represents the CD drive or mount point containing the DB2
Activation CD for the DB2 product or feature.

5. Click Apply to add the license key.

Related concepts:
* “License management” in Administration Guide: Implementation

Related tasks:
+ [“Checking DB2 license compliance” on page 26|

* “Registering a DB2 product or feature license key using the db2licm command”
in Installation and Configuration Supplement

Related reference:

+ ["DB2 product license files” on page 25|

Checking DB2 license compliance

Each DB2 product and feature has a license file associated with it. The license file
should be registered before using the DB2 product or feature. The License Center
lists product information on the main panel. DB2 products that do not have the
license registered show the License Type as not registered.

To verify license compliance of DB2 features, you can generate a compliance
report. The compliance report lists DB2 features out of compliance with your
current product entitlement. Each DB2 feature status is listed as either:

* In compliance: indicating no violations are detected

* Violation: indicating the feature is not licensed and has been used.

Note: Some DB2 functionality is only available under license when purchased as
part of a DB2 feature.

You can generate a compliance report using the License Center or the db2licm
command.

Procedure:

To generate the compliance report from the License Center, select
License+*Generate Compliance Report.

To generate compliance report using the db2licm command, enter the following
command from the command line:

* For Linux and UNIX operating systems:
db2instance_path/adm/db21icm -g filename
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* For Windows operating systems:
db2instance_path\adm\db21icm -g filename

where

* db2instance_path is where the DB2 instance was created.

* filename specifies the file name where output is to be stored.

DB2 features showing a violation must have the license key registered using either
the License Center or the db2licm command. See the related links for details.

Related concepts:

* “License Center overview” in Administration Guide: Implementation

Related tasks:

* [“Registering a DB2 product or feature license key using the License Center” on|

page 25|

* “Registering a DB2 product or feature license key using the db2licm command”
in Installation and Configuration Supplement

Related reference:

+ |“DB2 product license files” on page 25|

+ “db2licm - License management tool command” in Command Reference

Upgrading a Try and Buy license

If you installed a DB2 product with a try and buy license and now want to
upgrade to a full license you need to upgrade the product license key. You can also
use this method to upgrade from one license type to another. For example, to
upgrade from a User license to a CPU license.

Restrictions:
You cannot use this method to upgrade from one DB2 product to another.
Procedure:

To upgrade your DB2 license:
1. Download the activation CD from Passport Advantage.
2. Register the license key using the License Center.

Related concepts:
* “License Center overview” in Administration Guide: Implementation
* “DB2 installation methods” in Quick Beginnings for DB2 Servers

Related tasks:
* |“Checking DB2 license compliance” on page 26|

* [“Registering a DB2 product or feature license key using the License Center” on|

page 25|

Related reference:

+ ["DB2 product license files” on page 25|
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Part 2. Getting started with DB2 administration
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Chapter 5. Basic administration

Now that you have installed your DB2 product and verified its successful
installation, you are ready to create your own database. The following sections will
guide you through the steps of creating a new database that will take advantage of
DB2 automatic maintenance features.

Creating your own database

Database basics

A relational database presents data as a collection of tables. A table consists of a
defined set of columns and any number of rows. The data in each table is logically
related, and relationships can be defined between tables. Data can be viewed and
manipulated based on mathematical principles and operations called relations
(such as, INSERT, SELECT, and UPDATE).

A database is self-describing in that it contains, in addition to data, a description of
its own structure. It includes a set of system catalog tables, which describe the
logical and physical structure of the data; a configuration file, which contains the
parameter values associated with the database; and a recovery log, which records
ongoing transactions and transactions that can be archived.

Databases can be local or remote. A local database is physically located on the
workstation in use, while a database on another machine is considered remote.

You can:

* Create a database using the Control Center

* Add a database using the Control Center or Configuration Assistant
* Drop a database from the Control Center

* Backup a database using the Control Center

* Restore a database using the Control Center

* Configure a database using the Control Center

* Connect to a database using the Control Center

¢ Resolve database health alerts with the Health Center

Related concepts:

* |“Getting started with the Configuration Assistant” on page 54|

+ [“Getting started with the Control Center” on page 42|
+ |“Getting started with the Health Center” on page 49|

Related tasks:

* [“Verifying your new database” on page 32|

Creating your own database using the Create Database with
the Automatic Maintenance wizard

The Create Database with Automatic Maintenance wizard is the quickest way to
set up your own database. Based on basic information that you provide, the
wizard:
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* creates a new database on the disk or directory of your choice

* assigns disk space for your data

* configures the new database for optimal performance

* turns on automatic maintenance

* configures notification by e-mail or pager if the database needs attention

The Create Database with Automatic Maintenance wizard can be started from First
Steps or directly from within the Control Center.

Prerequisites:

* If you wish to start the wizard from First Steps, you must also have the First
Steps component installed. First Steps is part of the Getting started component
grouping in the DB2 Setup wizard. It is installed as part of a Typical installation
or may be selected when performing a Custom installation.

* You must have SYSADM or SYSCTRL authority to perform this task.

* For Linux, you must have Xwindow software capable of rendering a graphical
user interface for First Steps and the Control Center to run on your machine.
Ensure that you have properly exported your display. For example, export
DISPLAY=9.26.163.144:0.

* On Linux, ensure that you are logged on as the instance owner, db2instl by
default. An instance is a logical database manager environment where you
catalog databases and set configuration parameters.

Procedure:

1. Log on to the system with the user account that you want to use to create the
database.

2. Start the Create Database with Automatic Maintenance in the one of the
following ways:
* From First Steps: Click Create Your Own Database.

* From the Control Center: Click the All Databases folder. Click Create New
Database in the All Databases pane.

3. Follow the steps of the wizard. You will have to provide some details and
preferences about your new database, including such things as its name and
the contacts who can be notified under various conditions.

If you created your own database from First Steps, you will now want to start the
Control Center to begin exploring and working with your database. To do this,
click Work With Databases in First Steps.

Related concepts:

+ [“Database basics” on page 31|

Related tasks:
* |“Verifying your new database” on page 32|

Verifying your new database

Once you have launched the Control Center, you can verify that your database was
created by finding it in the Object Tree that fills the left side of the Control Center
window.
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Figure 1. Control Center with a database selected

Expand the Object Tree until you can see your database and select it. The right
side of the Control Center will fill with details about the database’s current
operation and links to relevant actions.

When you created your database with the Create Database with Automatic
Maintenance, you enabled certain Automatic maintenance features. The features are
set up and do not necessarily require any further attention. You may, however, find
it useful to know where their settings can be found and further configured.

There are automatic maintenance-related tools available. The first of these is the
Automatic Maintenance wizard, which you can start by clicking on the Maintenance
link in the Object Details Pane. As the wizard’s name suggests, it will allow you to
change the way in which automatic maintenance is carried out for your database.

Another tool is the Health Center. You can launch it by clicking on Monitor DB
Health in the Object Details Pane or by selecting Health Center from the Tools
menu. Under normal circumstances, you should never have to look at the Health
Center. If the health of your database needs attention, you will be notified by
e-mail. You can then find out more about what needs attention.

Related concepts:

+ [“Database basics” on page 31|

* “Control Center overview” in Administration Guide: Implementation

Related tasks:

* [“Creating your own database using the Create Database with the Automatic
Maintenance wizard” on page 31|
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Chapter 6. Automatic maintenance

Your DB2 product provides automatic maintenance capabilities for performing
database backups, and keeping statistics current as necessary.

Automatic database backup provides users with a solution to help ensure their
database is being backed up both properly and regularly, without either having to
worry about when to back up, or having any knowledge of the backup command.

Automatic statistics collection attempts to improve the performance of the database
by maintaining up-to-date table statistics. The goal is to allow the optimizer to
choose an access plan based on accurate statistics. Automatic statistics profiling
advises when and how to collect table statistics by detecting outdated, missing,
and incorrectly specified statistics and by generating statistical profiles based on
query feedback.

Enablement of the automatic maintenance features is controlled using the
automatic maintenance database configuration parameters. These are a hierarchical
set of switches to allow for simplicity and flexibility in managing the enablement
of these features.

The Configuration Advisor runs automatically when you create a database in DB2
Version 9. This autonomic computing feature provides significant performance
improvement to newly created databases, and causes little overhead to the system.

Also when you create a database in DB2 Version 9, AUTOMATIC STORAGE is
enabled by default. Automatic storage simplifies storage management by allowing
you to specify storage paths where the database manager can place table space
data, and where the database manager allocates space for various uses.

Self tuning memory is enabled by default, this autonomic feature simplifies the
task of memory configuration by automatically setting values for memory
configuration parameters and sizing buffer pools. When enabled, the memory
tuner dynamically distributes available memory resources between several memory
consumers including sort, package cache and lock list areas and buffer pools.

Automatic database backup

A database may become unusable due to a wide variety of hardware or software
failures. Automatic database backup simplifies database backup management tasks
for the DBA by always ensuring that a recent full backup of the database is
performed as needed. It determines the need to perform a backup operation based
on one or more of the following measures:

* You have never completed a full database backup

* The time elapsed since the last full backup is more than a specified number of
hours

* The transaction log space consumed since the last backup is more than a
specified number of 4 KB pages (in archive logging mode only).
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Protect your data by planning and implementing a disaster recovery strategy for
your system. If suitable to your needs, you may incorporate the automatic
database backup feature as part of your backup and recovery strategy.

If the database is enabled for roll-forward recovery (archive logging), then
automatic database backup can be enabled for either online or offline backup.
Otherwise, only offline backup is available. Automatic database backup supports
disk, tape, Tivoli Storage Manager (TSM), and vendor DLL media types.

Through the Configure Automatic Maintenance wizard in the Control Center or
Health Center, you can configure:

* The requested time or number of log pages between backups
* The backup media
* Whether it will be an online or offline backup.

If backup to disk is selected, the automatic backup feature will regularly delete
backup images from the directory specified in the Configure Automatic
Maintenance wizard. Only the most recent backup image is guaranteed to be
available at any given time. It is recommended that this directory be kept
exclusively for the automatic backup feature and not be used to store other backup
images.

The automatic database backup feature can be enabled or disabled by using the
auto_db_backup and auto_maint database configuration parameters. In a
partitioned database environment, the automatic database backup runs on each
database partition if the database configuration parameters are enabled on that
database partition.

Related concepts:

* “Developing a backup and recovery strategy” in Data Recovery and High
Availability Guide and Reference

+ |“Automatic statistics collection” on page 36|

* “Catalog statistics” in Performance Guide

* “Table and index management for MDC tables” in Performance Guide

* “Table and index management for standard tables” in Performance Guide
* “Table reorganization” in Performance Guide

* “Health monitor” in System Monitor Guide and Reference

Related reference:

* “auto_maint - Automatic maintenance configuration parameter” in Performance
Guide

Automatic statistics collection

The DB2 optimizer uses catalog statistics to determine the most efficient access
plan for any given query. Having out-of-date or incomplete statistics for a table or
an index could lead the optimizer to select a plan that is not optimal, slowing
down query execution. However, deciding which statistics to collect for a given
workload is complex, and keeping these statistics up to date is time-consuming.

With automatic statistics collection, part of DB2’s Automated Table Maintenance
feature, you can let DB2 determine which statistics are required by your workload
and which statistics need to be updated. With automatic statistics collection
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enabled, DB2 will automatically run the RUNSTATS utility in the background to
ensure the correct statistics are collected and maintained.

Starting in DB2 Version 9, automatic statistics collection is enabled by default when
a new database is created.

The performance impact of automatic statistics collection is minimized in several

ways:

e Statistic collection is performed using throttled RUNSTATS. Throttling controls
the amount of resources consumed by the RUNSTATS utility based on current
database activity: as database activity increases, the RUNSTATS utility runs more
slowly, reducing its resource demands.

* Only the minimal set of statistics for optimizing performance are collected. This
is achieved through the use of statistics profiling which uses information about
previous database activity to determine which statistics are required by the
database workload, and how quickly those statistics will become out of date
given the type of activity in the database.

* Only tables with high levels of activity (measured through the number of
updates, deletes and inserts) are considered for statistic collection. Large tables
(consisting of more than 4000 pages) are also sampled to determine whether the
high table activity has indeed changed the statistics. Statistics for these large
tables are only collected if warranted.

* The RUNSTATS utility is automatically scheduled to execute during the optimal
maintenance window specified in your maintenance policy definition. This
policy also specifies the set of tables that are within the scope of the automatic
statistics collection, further minimizing unnecessary resource consumption.

* While automated statistic collection is being performed, the affected tables are
still available for regular database activity (updates, inserts, deletes)as if
RUNSTATS were not running on the table.

Related concepts:
* “Automatic features enabled by default” in Administration Guide: Planning

* “Collecting statistics using a statistics profile” in Performance Guide

Related tasks:

¢ “Using automatic statistics collection” in Performance Guide

Related reference:

¢ “RUNSTATS command using the ADMIN_CMD procedure” in Administrative
SQL Routines and Views

¢ “auto_maint - Automatic maintenance configuration parameter” in Performance
Guide

* “util_impact_lim - Instance impact policy configuration parameter” in
Performance Guide

e “RUNSTATS command” in Command Reference
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Chapter 7. DB2 administration and development tools

This section describes the DB2 administration and development tools. It explains
what each tool is used for and why you might want to use it. It tells you how to
invoke a tool and presents basic usage information.

+ [“Basic GUI navigation concepts’]|

* |“Getting started with the Control Center” on page 42|

* [“Getting started with the Command Editor” on page 46|

+ |“Getting started with the Task Center” on page 50|
* |“Getting started with the Health Center” on page 49|
* [“Setting up notification and contact lists” on page 46|

* |“Getting started with the Journal” on page 52|

* |“Getting started with the Configuration Assistant” on page 54|

* |“Getting started with the Replication Center” on page 55|

* |“Getting started with the Web Command Center” on page 56|
* |“Getting started with the Web Health Center” on page 57|

Basic GUI navigation concepts

Here are some basic GUI concepts you should be familiar with.
Start Menu:

The Start menu is the starting point for using the Administration tools on Windows
operating environments. From the Start menu, select Programs —> IBM DB2—>
[DB2 copy name] —>General Administration Tools —> Control Center. You can
also start other centers or tools such as the Journal, the Replication Center, and the
Task Center from the Start menu as well as select the command line tools, the
development tools, the monitoring tools, and the Information Center.

To start the GUI Administration tools from the Linux desktop environment, open
the IBM DB2 folder on your Gnome or KDE desktop and then select Control
Center.

Control Center menu bars:

The Menu bar is a special panel that is displayed at the top of the window. It
contains menu options that allow you to access drop-down menus. From the
drop-down menus, you can select menu items. Items in the menu bar include
actions that affect the objects in the center you are using. For example, menu items
under Control Center include actions that affect the entire Control Center.

Menu items under Selected dynamically change to include only those actions that
apply to currently selected objects in the contents pane. Menu items under Edit
include actions that let you work with objects in the contents pane. Menu items
under View include actions that let you customize the display of objects in the
contents pane. Menu items under Help include actions that display help
information and allow you to work with the Information Center and Tutorials.
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Toolbars:

Toolbars are panels that contain icons representing functions you can perform.
Toolbars are located below the menu bar. To see a brief description of a tool, place
your cursor over its icon and hover help will tell you what function each icon
represents. Toolbars provide quick access to the functions you can perform. The
functions can also be selected in the View menu.

A Contents pane toolbar is located below the contents pane. It allows you to tailor
the information in the contents pane.

Wizards:

Wizards are integrated into the administration tools. They assist you in completing
a single task by stepping you through the task. To select a wizard, from the
Control Center window, select Tools —> Wizards from the menu bar. The Wizards
window opens. Select the wizard you want to use. Select the object for which you
want help and follow the instructions to complete the task.

The wizard task overview on the first page of the wizard lists any prerequisite
steps and briefly describes every page of the wizard. Other pages of the wizard
may contain links to conceptual or reference information to help you understand
the function of the wizard. From a wizard, you can launch other wizards, windows
or notebooks.

Object trees:

Object trees display the system and database objects graphically in the left
navigation pane, enabling you to see the hierarchical relationship between different
objects and to work with those objects. You can expand the object tree to expose
the content. The exposed content is displayed as folders beneath the object tree.
Each folder represents an object type. If the object tree is collapsed, the folders no
longer appear in the view of the object tree.

Objects on your local workstation and any remote systems that can be connected to
and from your local system are displayed in the object tree. Some objects, such as
tables and views, do not contain folders and appear at the bottom of the object
tree. Also if you right-click on the object folder there are actions available for the
object. For example, if you right-click on a table you can choose to create a table.

When you select an object folder in the object tree, the objects that reside in the
folder are displayed in the contents pane. To invoke an action on an object,
right-click the object to open a pop-up menu of available actions. You can also
invoke an action on the object by selecting the object then clicking the Selected
menu option from the menu bar.

Contents Pane (Details view):

The Contents pane allows you to display large amounts of complex tabular data in
a flexible manner.

You can filter, sort, and customize Contents pane columns. You can also save your
changes as a view, enabling you to quickly switch between different views of the
same data. To create and save customized views, select View from the toolbar at
the bottom of the Contents pane.
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Figure 2. Contents Pane view

Filtering in the Contents pane simply hides data that has already been retrieved
from the database. If your database has so many objects that retrieval time is an
issue, you may prefer to retrieve only a subset of the objects (for example, tables).
This filtering is referred to as Object Filtering and is explained in the next section.

Object filtering:

Object filtering enables you to work with a subset of all the objects in the database
in the Control Center. For example, if you only need to work with your own tables
and not those created by someone else, you can set up an object filter so that only
those tables will be retrieved from the database. You will not have to wait for data
about the other tables to be retrieved.

Right-click on an object folder in the object tree and select Filter->Create. The Filter
notebook opens allowing you to select which objects you would like to retrieve
from the database.

Once you have created a filter, the filter icon will appear beneath the filtered object
in the object tree to indicate that a filter has been set. To remove the filter and
display all the objects in the Contents pane, right click the object folder and select
Filter->Remove.

You can further customize your view by selecting the filter icon from the toolbar at
the bottom of Contents pane described above. This filtering will only hide data
that has already been retrieved from the database.Filtering enables you to work
with a subset of displayed objects in the Control Center. Two forms of filtering
exists. The first form of filtering allows you to create a customized view of objects
which you would like to appear in the Contents pane of the Control Center.

Infopops:

An infopop is a pop-up window that is displayed when a control in a window or
notebook has focus and you press F1. Holding the mouse cursor over a control in a
window or notebook also causes the infopop to display. Infopops contain a
description of the field or control. They may also list restrictions and requirements
or provide instructions.
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Infopops are disabled or re-enabled from the Documentation tab of the Tools
Settings notebook. To disable or enable infopops for the Configuration Assistant,
select the Display Infopops checkbox menu in the Help menu from the
Configuration Assistant tool.

Mandatory fields:

Mandatory fields are fields for which you must supply information. Mandatory
fields are displayed with thick red borders around the field. When information is
entered in the mandatory field, the red border is no longer displayed.

Help:

Help is available from icons on the toolbar or by using the Help menu.

@ displays help for getting started with the Control Center.
The Help menu displays menu items for displaying the online help index, general
information about the Control Center, and keyboard help. The menu also displays

the list of tutorials available with the DB2 product.

Related concepts:

* [“Getting started with the Control Center” on page 42|
* |“Getting started with the Health Center” on page 49|

Getting started with the Control Center

You can start the Control Center in the following ways:
* Enter the db2cc command.

* On Windows systems, click Start and select Programs —> IBM DB2 —> [DB2
copy name]—> General Administration Tools —> Control Center.

* On Linux systems, open the IBM DB2 folder on the desktop and select Control
Center. The first time you invoke the Control Center, you will be prompted to
select the view you want to display. The options are basic, advanced, and
custom. You can uncheck the Show this window box at startup time so this
windows does not appear every time you invoke the Control Center.

e Select Control Center from the Tools menu of another tool.

¢ (Click the Control Center icon %I:, from the toolbar of another tool.
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Figure 3. Control Center views

Three different Control Center views are available.

Basic

From this folder you can work with all the databases to which you have
been granted access, including their related objects such as tables and
stored procedures. This view does not include the database objects that are
at a higher level than the database in the DB2 hierarchy (systems and
instances). It provides you with the essentials for working with data.

Advanced

Custom

This view provides you with all the folders, folder objects, and actions
available in the Control Center. You should select this view if you are

working in an enterprise environment and want to connect to DB2 for
z/0S or IMS.

This view allows you to tailor the Control Center to your needs. You select
the folders, folder objects, and object actions that you want to appear in
your Control Center view. Click Custom —> Modify. The Customize
Control Center View window opens.

In the Control Center, you can administer all of your systems, instances, databases,
and database objects. You can also open other centers and tools to help you
optimize queries, jobs, and scripts; create stored procedures; and work with DB2
commands.

The following are some of the key tasks that you can perform with the Control

Center:

* Add DB2 systems, existing instances, and existing databases.
¢ Create database objects that will be added to the object trees.
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* View the details of database objects. You can look at a table’s constituent
columns and see the current state of a database.

* Manage database objects. You can create, alter, and drop databases, table spaces,
tables, views, indexes, triggers, and schemas. You can also manage users.

* Manage data. You can load, import, export, and reorganize data. You can also
gather statistics.

* Perform preventive maintenance by backing up and restoring databases or table
spaces.

* Configure and tune instances and databases.
+ Manage database connections, such as DB2 Connect " servers and subsystems.

* Manage applications.

e Launch other tools such as the Command Center and the Health Center.
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Figure 4. Control Center advanced view with a table selected

The main Control Center window is split into three sections, or panes. On the left
side, there is an Object Tree. This tree displays all of your databases and their
constituent objects (such as tables, views, and indexes).

When you select any one of the available database objects or object folders in the
Object Tree, the Contents Pane, occupying the top half of the right side of the
Control Center window, fills with a list of the relevant objects. For example, by
selecting a database’s Table folder in the object tree, you will fill the Contents Pane
with all of that database’s tables, as well as some information about each.

There is, however, more detail about any given object than will fit in the Contents
Pane; the bottom pane on the right side, the Object Details Pane provide the
additional information. Clicking on an object in the Contents Pane will bring up
detailed information about that object in the Object Details Pane. When you click
on a table object in the object list, you will see a listing of that table’s columns, as
well as other table attributes and some actions that are relevant to tables.
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The Maintenance status category in the Object Details pane will tell you whether
or not automatic maintenance is enabled for the database in question. Clicking on
Maintenance will allow you to enable, configure, and disable automatic
maintenance for the database. If you created the database with the Create Database
Using Automatic Maintenance wizard, from First Steps or within the Control
Center, then Maintenance should be in the "enabled” state.

*« Control Center,

Cortrol Center  Selected  Eclt  Wiew Tools  Help

LHEREERE B iE

(] Object View
£2 Control Center
e AINIC - DE2 - SAMPLE
[~ Al Sysh
S e Mame B
QAR e a
(=7 Instances
5 @ pa2 G views
Ali
B[] Databases 3 aliases
-0 (3 Micknames
0] Tables [ Cache Ohjects
[ Wiews £ Triggers
-] Aliases ] Schemas
(23 Micknates 1 Inclexes L
£ ache Objects se the conterts pane ta display and wark with system and database obiects. The contents pane displays those okiects
#-[7] Cache Ohject: Use th rtent: to dizpl il k with =yt ol chatab hjects. The ntent: dizplays th bject:

that make up the contents of the ohisct that is selected in the object tree

P T
3 Triggers H To invoke actions for one or more obiects in the corterts pane, select the objects. Then right-click a selected object to —
£ Schemas OpEn & pop-up menu of available actions and select 3 menu choice. A window of notebook opens to ouide you through

o[ Indexes the steps required to complete the action. —
Click Esc to close this infopop.
(3 Table Spaces System CHIAINID
(] Evert Monitars Type Local DB State: Started Ij:‘ Ston.
- [ Butfer Paols Actions: LastBackuz  Hone (G Backup Database
[ Application Objects ; i i n
: g pp I Application List size 45 MB View Storage
User and Group Ohjects
L) f3) Desin Advisor Capacity 10532 MB
[#-[7] Federated Datahase Objects ctivity Monitor ——kC
Activily Monitor
(7] XML Schema Repository (XSR) - Heatth: Hormal @ Wanitor DE Health
-] TooLsoe —
Mantenance:  Partially automated [z Maintenance
[#-[1] All Databases or Create New Database

Figure 5. Control Center advanced view with a database selected

To schedule tasks through the Control Center, you must first create a tools catalog.
If you did not create a tools catalog when you installed your DB2 product, you can
select Tools—> Tools Settings —> Scheduler Settings and create one now.

To customize objects and actions:

Use the Control Center View window to select the view of the Control Center with
which you want to work.

Your DB2 product is made up of various components and objects. These objects are
used to store and work with data. The database itself is only one of a number of
objects that make up a database product’s hierarchy of objects. Other components
include systems, tables, views, triggers, and indexes. The DB2 database server
presents its hierarchy as an object tree in the left pane of the Control Center.

You can choose to have the Control Center View window open whenever you
open the Control Center by selecting Show this window at startup time. Your

Control Center now displays your view selection.

Related concepts:
e “Control Center overview” in Administration Guide: Implementation
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Setting up notification and contact lists

For your DB2 product to contact you or others regarding the health of your
databases, you will have to set up notification and contact lists. If you did not do
this during the DB2 installation, you can manually set up these lists.

Procedure:

To set up notification and contact lists:

1.
2.

Log on as the instance owner or a user with SYSADM authority.
If the SMTP server was not specified during the installation process, you can
configure it manually using the following command:

db2 update admin cfg using smtp_server hostl

where hostl represents the TCP/IP host name for the SMTP server used for
e-mail notification. You can also update this information using the Create
Database with Automatic Maintenance wizard, or the Troubleshoot Alert
Notification wizard in the Health Center.

If you want the contact information to be located on a remote DB2
administration server (DAS), you can specify the contact_host parameter using
the following command:

db2 update admin cfg using contact_host host2

where host2 represents the TCP/IP host name where the DAS is running. If the
contact_host parameter is not specified, the DAS assumes the contact
information is local.
Turn on the scheduler using the following command:

db2 update admin cfg using sched_enable on

For these changes to take effect, you need to restart the DAS use the following
commands:

db2admin stop
db2admin start

From either the Task Center or the Health Center, click the Contacts icon h[%
in the Task bar. Select System name, then click Add Contact. Type in contact
information and then click OK.

Related reference:

“db2admin - DB2 administration server command” in Command Reference

Getting started with the Command Editor

You can start the Command Editor in the following ways:

On Windows systems, click Start and select Programs —> IBM DB2 —> [DB2
copy name]—> Command Line Tools —> Command Editor.

Select Command Editor from the Tools menu of another tool.

Click the Command Editor icon from the toolbar of another tool.

Use the Command Editor to:

Run DB2 commands and SQL statements.
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* Work with query results.
 View a graphical representation of the access plan for explained SQL statements.
* Run commands in sequence.

* Create and save a script. You can optionally store a saved script in the Task
Center, where you can schedule the script to run at a specific time.
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Figure 6. Command Editor window

On the Commands page, you can execute an SQL statement or DB2 CLP
command. You do not need to precede the command by "DB2".

Run and create a visual access plan, by clicking the Execute and Access plan icon
(from the left of the toolbar)

Run a command or statement, by clicking the Execute icon (at the left of the
toolbar).

On the Query Results page, you can see the results of the queries. You can also
save the results or edit the contents of the table.

On the Access Plan page, you can see the access plan for any explainable
statement that you specified on the Interactive page or the Script page when you
click on the Access plan or Execute and Access plan icon. DB2 generates the access
plan when it compiles the SQL statement. You can use this information to tune
your queries for better performance.

If you specify more than one statement on the Script page, an access plan is not
created unless you highlight a single statement.

You can get help writing SQL with the SQL Assist tool available from the Selected
menu of the Command Editor menu.
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To run commands and SQL statements::

1.

10.

11.

12.

13.

14.

15.

To open an embedded Command Editor, expand the Control Center object tree
until you find a DB2 database. Right-click the object and select Query from
the pop-up menu. A Command Editor tile opens in the Control Center.

To open a stand-alone Command Editor from the Start menu, select Programs
—> IBM DB2 —> [DB2 copy name] —> Command Line Tools —>
Command Editor.

Select a target database to connect to. Targets that currently have connections
or have had connections during the current session are listed in the Target
drop-down list. If your target is not listed, click Add and select a target from
those available on the Specify Target window. You can also type the connect to
database statement.

In the top pane, type the commands or SQL statements that you want to
execute.

You can select commands and statements previously executed in this session

from the History window. Clickﬂ to open the History window.

i
You can execute commands and statements stored in a file. Click E'-" to
locate the file using the file browser Open window.

You can specify the character to be used as the termination character for your
statements and commands in the Statement termination character field. This
termination character will override the character that you may have specified
in the Tool Settings notebook.

For scripts containing CREATE PROCEDURE or CREATE TRIGGER
statements, it is suggested that a termination character other than a semicolon
be used, as the body of these statements might themselves contain one or
more semicolons.

When stored procedures are using the same character as a delimiter, as this
would cause execution problems.

Click E’" to execute the commands or statements.

Click to generate a graphical representation of the access plan for
explainable SQL statements (for example, SELECT, INSERT, and UPDATE). An
access plan indicates the order of operations for accessing requested data.

Click _) to execute explainable SQL statements and generate access
plans. The availability of push buttons changes depending on the database
target for your commands.

View the execution results. Command results are displayed in the output area
of the Commands page, while SQL results are returned on the Query Results
page. The access plan appears in graphical form on the Access Plan page.

Optional: The results from the most recently executed SQL statement are
displayed on the Query Results page. To change the value in any cell,
highlight the value and modify it. If the Automatically commit updates check
box is selected, changes made to a cell are committed immediately when focus
shifts off its row. If the check box is not selected, then click Commit to commit
your changes, or click Rollback to rollback any uncommitted changes.

You can also add, modify, and delete rows in the table.
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16. Optional: You can save your commands and statements in a file. Click to
specify a file using the file browser Save As window.

Related concepts:

+ |“Basic GUI navigation concepts” on page 39|

* |“Getting started with the Control Center” on page 42|

Getting started with the Health Center

You can start the Health Center in the following ways:

* On Windows systems, click Start and select Programs —> IBM DB2 —> [DB2
copy name]—> Monitoring Tools —> Health Center.

¢ Select Health Center from the Tools menu of another tool.

¢ (Click the Health Center icon from the toolbar of another tool.
¢ Enter the db2hc command.

* Click the health center status beacon when it appears on a DB2 window. On the
Tools Settings window, you can configure this beacon to appear on every DB2
window whenever an alert occurs.

Use the Health Center to monitor the state of the database environment and make
any necessary changes.

E= Health Center
Heafth Center Selected Edit ‘View Toolz  Help

LEBE R ORE GBE @ [ ¥ D

Il Chiects Alerts - DEZ
l g% [ 33 “ g% " gg - | - | Health Incicstor = | Walue = | Uit % | Category
= DB2
%@ = Alarm
- [3h SAMPLE
Monitor Heap Litilization 100 % Metnory
L[y TOOLSDE

4 | b
Tof tems displaved | 1% 20 do B W IF &° p° ‘ By Ohi.. “View

Health monitor data is refreshed. ( 302006 1:56 PM )

Figure 7. Health Center window

When you use DB2, a health monitor continuously monitors a set of health
indicators. If the current value of a health indicator is outside the acceptable
operating range defined by its warning and alarm thresholds, the health monitor
generates a health alert. DB2 comes with a set of predefined threshold values,
which you can later customize. For example, you can customize the alarm and
warning thresholds for the amount of space used in a table space.
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Depending on the configuration of the DB2 instance, the following actions can
occur when the health monitor generates an alert:

* An entry is written in the administration notification log, which you can read
from the Journal.

* A script or task is executed.

* An e-mail or pager message is sent to the contacts that you specify for this
instance.

The following are some of the key tasks that you can perform with the Health
Center:

 View the status of the database environment. Beside each object in the
navigation tree, an icon indicates the most severe alert for the object (or for any
objects contained by that object). For example, a green diamond icon beside an
instance means that the instance and the databases contained in the instance do
not have any alerts.

* View the alerts for an instance or a database. When you select an object in the
navigation tree, the alerts for that object are shown in the pane to the right.

* View detailed information about an alert, and recommended actions. When you
double-click an alert, a notebook appears. The first page shows the details for
the alert. The second page shows any recommended actions.

* Configure the health monitor settings for a specific object, and the default
settings for an object type or for all objects within an instance.

* Select which contacts will be notified of alerts with an e-mail or pager message.
* Review the history of alerts for an instance.

You can use the toggle buttons at the top of the navigation bar to filter the alerts
according to their severity:

@ [ TN QL [~ Fa
. I 2 80 | 8o | e® | Displays only alarms (the most severe type of alert)

o I @s | @A | Qs | . .
g S @¢ | Displays alarms and warnings

. e s
@ | @a I @ | Y | . . .

e 2o | @@ J @@ | @¢ | Displays alarms, warnings, and attentions
@ | @n | @A I @n .

e | 20 | 50 | 8¢ J 8¢  Displays all alerts

The Web version of the Health Center includes a subset of these features.

Related concepts:

e [“Basic GUI navigation concepts” on page 39
g 1% pag

* [“Getting started with the Control Center” on page 42|

Getting started with the Task Center

You can start the Task Center in the following ways:
* Select Task Center from the Tools menu of another tool.

S
* Click the Task Center icon from the toolbar of another tool.
* Enter the db2tc command.
* On Windows systems, click Start and select Programs —> IBM DB2—> [DB2
copy name] —> General Administration Tools —> Task Center.
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To use the Task Center, you must first create a tools catalog. If you did not create a
tools catalog when you installed DB2, you can select Tools —> Tools Settings —>
Scheduler Settings and create one now.
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Figure 8. Task Center window

Use the Task Center to run tasks, either immediately or according to a schedule,
and to notify people about the status of completed tasks. The Task Center includes
functionality from the Script Center in previous DB2 versions, plus additional
functionality.

A task is a script, together with the associated success conditions, schedules, and
notifications. You can create a task within the Task Center, create a script within
another tool and save it to the Task Center, import an existing script, or save the
options from a DB2 dialog or wizard such as the Load wizard. A script can contain
DB2, SQL, or operating system commands.

For each task, you can do the following;:
e Schedule the task
* Specify success and failure conditions

* Specify actions that should be performed when this task completes successfully
or when it fails

* Specify e-mail addresses (including pagers) that should be notified when this
task completes successfully or when it fails

You can specify conditional coding by creating task actions. Each task action
consists of a task and the action that should be performed on the task. For
example, task 1 could have the following task actions:

o If task 1 is successful, task action A enables the schedule for task 2.
o If task 1 fails, task action B runs task 3.

You can also create a grouping task, which combines several tasks into a single

logical unit of work. When the grouping task meets the success or failure
conditions that you define, any follow-on tasks are run. For example, you could
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combine three backup scripts into a grouping task and then specify a
reorganization as a follow-on task that will be executed if all of the backup scripts
execute successfully.

To see the most recent information, click the Refresh icon' “.* button. You can

view the results as follows:

* To see the results from the last time a task was executed, right-click the task and
select Show Results.

* To see the results from every time a task was executed, open the Journal. In the
Journal, you can right-click the task execution that you are interested in and
select Show Results.

To see help text for a message that appears in the execution results, open the
Command Center and enter the error message preceded by a question mark. For

example, enter ? SQL0100 to get more information about message SQLO100W.

Several customizable saved views are available via the pull-up menu at the bottom
of the Task Center.

Related concepts:

* [“Getting started with the Command Editor” on page 46|

* |“Getting started with the Journal” on page 52|

Getting started with the Journal

You can start the Journal in the following ways:

* Select Journal from the Tools menu of another tool.

* (Click the Journal icon from the toolbar of another tool.

* On Windows systems, click Start and select Programs —> IBM DB2 —> [DB2
copy name] —>General Administration Tools —> Journal.

The Journal displays historical information about tasks, database actions and
operations, Control Center actions, messages, and alerts.
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Figure 9. Journal window

. . . . [
To see the most recent information, click the Refresh icon ‘:"" button.

The Task History page shows the results of tasks that were previously executed.
You can use this information to estimate how long future tasks will run.

The Task History page contains one row for each execution of a task. The Task
Center contains only one row for each task no matter how many times the task is
executed. Each row in the Task Center could be directly related to multiple rows in
the Task History page of the Journal.

For each completed execution of a task, you can perform the following actions:
* View the execution results

¢ View the task that was executed

 Edit the task that was executed

* View the task execution statistics

¢ Remove the task execution object from the Journal

To perform one of these actions, right-click a completed task execution and select
the corresponding action from the pop-up menu that appears.

Database History:

You can check the status of key events in the life of your database using the
database history. The Database History page in the Journal lists a record of
recovery and administrative events:

* A database or table spaces are backed up, restored or rolled forward.
* A table space is created, altered, quiesced, renamed or dropped.

* A table is loaded, dropped, reorganized.

* A database is recovered.
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Figure 10. Database History

The Messages page shows messages that were previously issued from the Control
Center and other GUI tools.

The Notification Log page shows information from the administration notification
log. You can filter the list. For example, you can show only alerts from the health
monitor.

Several customizable saved views are available using the pull-up menu at the
bottom of the Journal.

Related concepts:
* [“Getting started with the Health Center” on page 49|
+ |“Getting started with the Task Center” on page 50|

Getting started with the Configuration Assistant

You can start the Configuration Assistant in the following ways:
* Enter the db2ca command.

* On Windows systems, click Start and select Programs —> IBM DB2 —> Set-up
Tools —> Configuration Assistant.

* On Linux systems, open the IBM DB2 folder on the desktop and select
Configuration Assistant.

Use the Configuration Assistant to configure your clients.

You must configure your DB2 clients so they can work with the available objects,
as follows:

* To access an instance or database on another server or system, the DB2 database
server must catalog that system in the node directory of the client.

* To access a database, the DB2 database server must catalog database information
in the database directory of the client.

From the Configuration Assistant, you can perform various tasks including:
* Add new database objects to access a remote database
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* Work with existing database objects

* Bind applications

* Set database manager configuration parameters for DB2 clients
* Import and export configuration information

* Set DB2 registry parameters

¢ Change passwords

¢ Test connections

* Configure CLI settings

The graphical interface makes these complex tasks easier through:

* Wizards that help you perform certain tasks

* Dynamic fields that are activated based on your input choices

* Hints that help you make configuration decisions

* Discovery that can retrieve information about selected database objects

The Configuration Assistant displays a list of the databases to which your
applications can connect. Each database is identified by its database alias. You can
use the Add Database wizard to add databases to the list. You can use the Change
Database wizard to alter the information that is associated with databases in the
list.

From the View menu, you can select an advanced view, which uses a notebook to
organize connection information by object: Systems, Instance Nodes, Databases,
Database Connection Services (DCS), and Data Sources. You can use the notebook
pages to perform object-specific actions.

Related concepts:

* [“Getting started with the Control Center” on page 42|

+ |[“Basic GUI navigation concepts” on page 39|

Getting started with the Replication Center

You can start the Replication Center in the following ways:
* Select Replication Center from the Tools menu of another tool.

¢ (Click the lﬁ}@ icon from the toolbar of another tool.
¢ Enter the db2rc command.

* On Windows systems, click Start and select Programs —> IBM DB2 —>
General Administration Tools —> Replication Center.

Use the Replication Center to administer replication between a DB2 database and
another relational database (DB2 or non-DB2). From the Replication Center, you
can define replication environments, apply designated changes from one location
to another, and synchronize the data in both locations.

The first time you invoke the Replication Center, the Replication Center launch pad

appears with three views: SQL Replication, Q Replication, and Monitoring and
Alarms.

Chapter 7. DB2 administration and development tools 55



£ Replication Center,
Replication Center  Selected  Edit “iew Tools  Help

LR E @O RE @i

@

'» Replication Center

Replication Certer

-7 SaL Replication
(7 Definitions

Marme

-] Capture Control Servers
-7 Apply Cortrol Servers
BE@ Operations
----- L& Capture Cantrol Servers
(- Ch(\:) Apply Contral Servers
=7 @ Replication
E| (7 Defintions
<7 @ Capture Servers
-7 @ Apply Servers
C@} Crperations
----- C@} G Capture Servers
b E@} G Apply Servers
9% Monitoring and Alerts
- % Monitor Contral Servers

(77 Sl Replication
3 @ Replication
EE- Monitoring and Lledts

3 of 3 items displayed lAz g‘#

-
Default ...

CER N

Wign

Figure 11. Replication Center window

The following are some of the key tasks that you can perform with the Replication

Center:

* Register replication sources
* Create subscription sets
Operate the Capture program
Operate the Apply program

Monitor the replication process

Related concepts:

Create replication control tables

Perform basic troubleshooting for replication

» |“Basic GUI navigation concepts” on page 39|

* [“Getting started with the Control Center” on page 42|

Getting started with the Web Command Center

Use the Web version of the Command Center to execute SQL statements, DB2
commands, and OS commands against a remote DB2 server, either interactively or
in scripts. This is particularly useful for database administrators and experienced
users who need to be able to work with the database at any time, from any place.
The Web version of the Command Center includes most of the features of the full
Command Center, but it does not currently include Visual Explain or SQL Assist.

To access the DB2 server, you use an HTML 4.0-compliant Web browser that runs
on any computing device from a desktop computer to a Personal Digital Assistant
(PDA). The browser is a client, which communicates with a middle-tier application
server. The application server communicates with the DB2 server. Secure Socket
Layer (SSL), the same technology that is used for most Internet banking and secure
e-commerce transactions, is used for all communication.
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The client can be any computing device that supports an HTML 4.0-compliant Web
browser. The browser does not need to support Java, JavaScript ", or cookies. The
middle tier must have DB2 Web Tools installed. DB2 Web Tools requires an
application server, such as IBM WebSphere® or BEA WebLogic.

If you are the database administrator of a large center, you could use the Web tools
as follows:

* While you are away from the office, attending a conference, you receive an
urgent message on your PDA about a database problem.

* Using the PDA, you securely log on to a portal where DB2 Web Tools is
installed.

* You use the Web versions of the Health Center and the Command Center to
investigate the problem.

* You use the Web version of the Command Center to execute SQL, DB2, and OS
commands that fix the problem.

Related concepts:

* |“Getting started with the Command Editor” on page 46|
+ [“Getting started with the Web Health Center” on page 57|
¢ “DB2 Web Command Center” in Installation and Configuration Supplement

Related tasks:

* “Deploying DB2 Web Tools on WebSphere application servers” in Installation and
Configuration Supplement

Getting started with the Web Health Center

Use the Web version of the Health Center to monitor the health of remote
databases. This is particularly useful for database administrators and experienced
users who need to be able to work with the database at any time, from any place.

The Web version of the Health Center includes a subset of the features of the full
Health Center. You can view the active alerts for an instance, view the details,
history, and resolution recommendations for an alert, and apply some
recommendations through the Web version of the Command Center.

To access the DB2 server, you use an HTML 4.0-compliant Web browser that runs
on any computing device from a desktop computer to a Personal Digital Assistant
(PDA). The browser is a client, which communicates with a middle-tier application
server. The application server communicates with the DB2 server. Secure Socket
Layer (SSL), the same technology that is used for most Internet banking and secure
e-commerce transactions, is used for all communication.

The client can be any computing device that supports an HTML 4.0-compliant Web
browser. The browser does not need to support Java, JavaScript, or cookies. The
middle tier must have DB2 Web Tools installed. DB2 Web Tools requires an
application server, such as IBM WebSphere or BEA WebLogic.

If you are the database administrator of a large center, you could use the Web tools
as follows:

* While you are away from the office, attending a conference, you receive an
urgent message on your PDA about a database problem.
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* Using the PDA, you securely log on to a portal where DB2 Web Tools is
installed.

* You use the Web versions of the Health Center and the Command Center to
investigate the problem.

* You use the Web version of the Command Center to execute SQL, DB2, and OS
commands that fix the problem.

Related concepts:

* [“Getting started with the Health Center” on page 49|

* |“Getting started with the Web Command Center” on page 56|

* “DB2 Web Health Center” in Installation and Configuration Supplement

Related tasks:

* “Deploying DB2 Web Tools on WebSphere application servers” in Installation and
Configuration Supplement
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Appendix A. Installing DB2 servers using response files

Response file installation basics

Unlike the DB2 Setup wizard, a DB2 response file installation lets you install DB2
products without any user interaction.

A response file is a text file that contain setup and configuration information. A
response file specifies configuration and setup parameters and the products and
components to install.

This method is useful not only for large-scale deployments of DB2 products, but
also for embedding the DB2 installation process transparently inside your
customized installation and configuration procedure.

You can create a response file by any of the following methods:

* Modifying one of the sample response files that are provided. Sample response
files are located in the DB2 product CD under the directory:

db2/platform/samples

where platform refers to the appropriate hardware platform.

* Using the DB2 Setup wizard to save the setup and configuration data according
to the input you provided. If you choose the option to create a response file in
the DB2 Setup Wizard, the response files (one for the server, and one for the
partition, if you are setting up a multi-partitioned environment) will be saved by
default at this location. The default names of the files are namel and name?2.

* Using the response file generator to create a response file from an existing
installed and configured DB2 product (Windows only).

A response file installation can also be referred to as a silent installation or an
unattended installation.

Related concepts:

* |“Response file considerations” on page 61|

* “The response file generator (Windows)” in Installation and Configuration
Supplement

Related tasks:
+ [“Creating a response file using the DB2 Setup wizard” on page 62|

Related reference:
* “Available sample response files” in Installation and Configuration Supplement

* “Response file keywords (Windows and UNIX)” in Installation and Configuration
Supplement

Response file considerations

You should understand the following considerations before proceeding with a
response file installation:
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* Although response files in Version 8 and Version 9 have similar formats, there
are version limitations as to where response files can be used. For example, any
response file generated in DB2 Version 9 can only be used to install DB2 Version
9; it cannot be used to install DB2 Version 8. The opposite is also true, where
response files generated in DB2 Version 8 cannot be used to install DB2 Version
9. This is primarily caused by mandatory keywords that are new in Version 9.

 If you are using the DB2 Setup wizard:

— You can save your settings in a response file during the installation in the
Select the installation action panel of the DB2 Setup wizard.

— You are creating a response file based on just the installation you are
performing. This method is recommended if you have either a fairly simple
configuration or if you want to create a response file that you plan to later
customize.

— A response file is only generated if you allow the installation process to
complete, and it completes successfully. If you cancel the installation, or if the
installation fails, the response file is not created.

* You can use a response file to install an identical configuration across every
workstation on your network or to install multiple configurations of a DB2
product. You can then distribute this file to every workstation where you want
this product to be installed.

* If you use the response file generator (Windows only), you are creating the
response file based on an existing installation. This method is recommended
when you have a more complex configuration, one that you manually
configured. If you are using the response file generator after generating the
response file, you might need to input user names and passwords

Related concepts:

* ["Response file installation basics” on page 61|

Related tasks:

* “Response file installation of DB2 overview (Linux and UNIX)” in Installation
and Configuration Supplement

* “Response file installation of DB2 overview (Windows)” in Installation and
Configuration Supplement

Creating a response file using the DB2 Setup wizard

You can create a response file using the DB2 Setup wizard based on the installation
you are performing. This response file will be generated based on your DB2 Setup
wizard selections. You can then use the response file to perform an unattended
installation using the same settings.

Procedure:

To create a response file using the DB2 Setup wizard:

1. From the DB2 Setup launchpad, select Install New for the product you want
to install, or, select Work with Existing to select the DB2 copy you want to
work with.

2. Select the product or DB2 copy you want to install and click Next to launch
the DB2 Setup wizard.

3. Click Next on the Welcome page and accept the license agreement terms.
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4. In the Select the installation type window, select from Typical, Compact or
Custom installation.

5. In the Select the installation, response file creation, or both window, select
either the Save my installation setting in a response file option or the Install
product on this computer and save my settings in a response file option.
Then, in the Response file name field type the path where you want the DB2
Setup wizard to place the generated response file. By default, the response file
name is namel, and is saved in directoryl.

Notes:

a. If you select the Save my installation setting in a response file option, no
software is installed on the computer, only the response file is created with
the name specified in the Response file name field.

b. If you select a partitioned database installation, two response files will be
generated, one for the instance-owning computer and one for the
participating computers. The participating computer response file name is
generated based on the name of the instance-owning computer. By default,
the partition response file name is name2, and is saved in directory2.

6. In the Select the installation folder window, specify there directory where the
DB2 product is to be installed.

7. Proceed through the rest of the installation panels selecting the options you
want.

8. In the Start copying files and create response file window, review the
settings you selected.
9. To install the product, click Finish.
10. When the installation has completed, the DB2 Setup wizard will have placed
the generated response file in the path you specified. The response file
keywords are explained in Response file keywords. However, when the DB2

Setup wizard is used to create the response file, a special keyword
ENCRYPTED is added to the response file. For example:

DAS_PASSWORD = 07774020164457377565346654170244883126985535505156353
ENCRYPTED = DAS_PASSWORD

The keyword ENCRYPTED indicates the actual value of the password is not
the sequence of numbers shown.

Related tasks:

* “Response file installation of DB2 overview (Linux and UNIX)” in Installation
and Configuration Supplement

* “Response file installation of DB2 overview (Windows)” in Installation and
Configuration Supplement

Related reference:

* “Response file keywords (Windows and UNIX)” in Installation and Configuration
Supplement
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Appendix B. Language support

Changing the DB2 interface language (Windows)

The interface language of DB2 is the language that appears in messages, help, and
graphical tool interfaces. When installing DB2, you have the option of installing
support for one or more languages. If, at some time after installation, you want to
change the interface language for DB2 to one of the other installed interface
languages, use the steps outlined in this task.

Do not confuse languages supported by DB2 with languages supported by the DB2
interface. Languages supported by DB2, that is, languages that data can exist in, are
a superset of languages supported by the DB2 interface.

Prerequisites:

The DB2 interface language you want to use must be installed on your system.
DB2 interface languages are selected and installed when you install DB2 using the
DB2 Setup wizard. If you change the interface language of DB2 to a supported
interface language that has not been installed, the DB2 interface language will
default to the operating system language first, and if that is not supported,
English.

Procedure:

Changing the interface language for DB2 on Windows requires that you change the
default language setting for your Windows operating system.

To change the DB2 interface language on Windows:

1. Through the Control Panel on your Windows operating system, select Regional
Options.

2. In the Regional Options dialog window, change the default language setting for
the system to the language in which you want to interface with DB2.

Refer to your operating system help for additional information about changing the
default system language.

Related tasks:

+ |“Displaying topics in your preferred language in the DB2 Information Center”]
on page 84|

Related reference:

* [“Supported DB2 interface languages” on page 67

¢ “Supported territory codes and code pages” in Administration Guide: Planning
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Changing the DB2 interface language (Linux)

The interface language of the DB2 product is the language that appears in
messages, help, and graphical tool interfaces. When installing your DB2 product,
you have the option of installing support for one or more languages. If, at some
time after installation, you want to change the interface language to one of the
other installed interface languages, use the steps outlined in this task.

Do not confuse languages supported by the DB2 product with languages
supported by the DB2 interface. Languages supported by the DB2 product, that is,
languages that data can exist in, are a superset of languages supported by the DB2
interface.

Prerequisites:

Support for the DB2 interface language you want to use must be installed on your
system. DB2 interface language support is selected and installed when you install
DB2 using the DB2 Setup wizard. If you change the interface language of the DB2
product to a supported interface language that has not been installed, the DB2
interface language will default to the operating system language first, and if that is
not supported, English.

DB2 interface language support is selected and installed when you install your
DB2 product using the DB2 Setup wizard or by using the National Language
Package.

Procedure:

To check which public locales are available in your system, run the $ locale -a
command.

To change the DB2 interface language, set the LANG environment variable to the
desired locale.

For bourne (sh), korn (ksh), and bash shells:

LANG=<Tocale>
export LANG

For C shell:

setenv LANG <locale>

For example, to interface with the DB2 product in French, you must have the
French language support installed and you must set the LANG environment
variable to a French locale, for example, fr_FR.

Related tasks:

+ |“Displaying topics in your preferred language in the DB2 Information Center”]
on page 84

Related reference:

* |“Supported DB2 interface languages” on page 67

* “Supported territory codes and code pages” in Administration Guide: Planning
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Supported DB2 interface languages

DB2 language support for DB2 interfaces can be categorized into server group
languages and client group languages. Server group languages will translate most
messages, help, and DB2 graphical interface elements. Client group languages will
translate the DB2 Runtime Client component, which will include most messages
and certain help documentation.

Server group languages include: Brazilian Portuguese, Czech, Danish, Finnish,
French, German, Italian, Japanese, Korean, Norwegian, Polish, Russian, Simplified
Chinese, Spanish, Swedish, and Traditional Chinese.

Client group languages include: Arabic, Bulgarian, Croatian, Dutch, Greek,
Hebrew, Hungarian, Portuguese, Romanian, Slovak, Slovenian, and Turkish.

Do not confuse languages supported by the DB2 product with languages
supported by the DB2 interface. Languages supported by DB2 product that is,
languages that data can exist in, are a superset of languages supported by the DB2
interface.

Related tasks:
+ |“Changing the DB2 interface language (Linux)” on page 66|

+ [“Changing the DB2 interface language (Windows)” on page 65|

* “Capturing error and diagnostic information during migration” in Migration
Guide

Related reference:

¢ “Conversion table files for euro-enabled code pages” in Administration Guide:
Planning

* “Conversion tables for code pages 923 and 924" in Administration Guide: Planning
* “National language versions” in Administration Guide: Planning

* “Supported territory codes and code pages” in Administration Guide: Planning

Language identifiers for running the DB2 Setup wizard in another

language

If you want to run the DB2 Setup wizard in a language different from the default
language on your computer, you can start the DB2 Setup wizard manually,
specifying a language identifier. The language must be available on the platform
where you are running the installation.

Table 3. Language identifiers

Language Language identifier
Arabic (available on Windows only) ar
Brazilian Portuguese br
Bulgarian bg
Chinese, Simplified cn
Chinese, Traditional tw
Croatian hr
Czech cz

Appendix B. Language support 67



Table 3. Language identifiers (continued)

Language Language identifier
Danish dk
Dutch nl
English en
Finnish fi
French fr
German de
Greek el
Hungarian hu
Italian it
Japanese ip
Korean kr
Norwegian no
Polish pl
Portuguese pt
Romanian 10
Russian ru
Slovak sk
Slovenian sl
Spanish es
Swedish se
Turkish tr

Related reference:

* |“Displaying the db2setup command in your national language” on page 68

Displaying the db2setup command in your national language

The db2setup command queries the operating system to determine the existing
language settings. If the language setting of your operating system is supported by
db2setup, then that language will be used.

If your system uses the same code pages but different locale names than those
supported by the DB2 interface, you can still see the translated db2setup by setting
your LANG environment variable to the appropriate value by entering the
following command:

bourne (sh), korn (ksh), and bash shells:
LANG=<locale>
export LANG

C shell:
setenv LANG <locale>

where locale is a locale supported by the DB2 interface.

Related reference:
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* [“Supported DB2 interface languages” on page 67

+ “db2setup - Install DB2 command” in Command Reference
e “setup - Install DB2 command” in Command Reference
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Appendix C. Installing DB2 fix packs

Applying fix packs

A DB2 fix pack contains updates and fixes for problems (Authorized Program
Analysis Reports, or "APARs") found during testing at IBM, as well as fixes for
problems reported by customers. Every fix pack is accompanied by a document,
called APARLIST.TXT, that describes the fixes it contains.

Each fix pack contains a Readme and a set of Release Notes:

* The fix pack Readme provides instructions for installing and uninstalling the fix
pack.

* The Release Notes contain information about changes to the product.

You can access and read both the fix pack Readme and the Release Notes by
selecting the link for fix pack downloads at the DB2 Support Web site before
installing a DB2 product. The DB2 Support Web site is found at

[http:/ /www.ibm.com /software /data/db2/udb/support.html|

Fix packs are cumulative. This means that the latest fix pack for any given version
of DB2 contains all of the updates from previous fix packs for the same version of

DB2. It is recommended that you keep your DB2 environment running at the latest
fix pack level to ensure problem-free operation.

There are two types of fix pack images:

* A fix pack for each individual DB2 product. This fix pack can be applied on an
existing installation of the product, or can be used to perform a full product
installation where there is no existing DB2 installation.

* Universal fix pack (Linux or UNIX only). A universal fix pack services
installations where more than one DB2 product has been installed.

If national languages have been installed, you also require a separate national
language fix pack. The national language fix pack can only be applied if it is at the
same fix pack level as the installed DB2 product. If you are applying a universal
fix pack, you must apply both the universal fix pack and the national language fix
pack to update the DB2 products.

When installing a fix pack on a multi-partition database system, the system must
be offline and all computers participating in the instance must be upgraded to the
same fix pack level.

Prerequisites:

Each fix pack has specific prerequisites. See the Readme that accompanies the fix
pack for details.

Procedure:

1. Access and download the latest DB2 fix pack by selecting the link for fix pack
downloads from the DB2 Support Web site at fhttp://www.ibm.com /software/|
[data/db2/udb/support.html}

Related reference:
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* “db2setup - Install DB2 command” in Command Reference

* “installFixPack - Update installed DB2 products command” in Command
Reference

* “setup - Install DB2 command” in Command Reference
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Appendix D. Uninstalling your DB2 product

Uninstalling your DB2 product (Windows)

This task provides steps for completely removing your DB2 product from your
Windows operating system. You should only perform this task if you no longer
require existing your DB2 instances and databases.

If you are uninstalling the DB2 default copy, and you have other DB2 copies on
your system, you should use the db2swtch command to choose a new default
copy before you proceed with the uninstallation. Also, if your database
administration server (DAS) is running under the copy being removed, you should
move your DAS to a copy that is not being removed. Otherwise, you will have to
recreate the DAS using db2admin create command after the uninstall and you
might have to reconfigure the DAS for some functionality to work.

Procedure:

To remove your DB2 product from Windows:

1. Drop all databases. You can drop databases using the Control Center or drop
database command. If you drop your databases, all of your data will be gone.

2. Stop all DB2 processes and services. This can be done through the Windows
Services panel or by issuing the db2stop command. If DB2 services and
processes are not stopped before attempting to remove your DB2 product, you
will receive a warning containing a list of processes and services that are
holding DB2 DLLs in memory.

3. You have two options for removing your DB2 product:

Add/Remove Programs
Accessible through the Windows Control Panel, use the Add/Remove
Programs window to remove your DB2 product. Refer to your
operating system’s help for more information about removing software
products from your Windows operating system.

db2unins command
You can run the db2unins command to remove your DB2 product.
Using this command, you can uninstall multiple DB2 products at the
same time using the /p parameter. You can also silently uninstall DB2
products by using /u parameter which will remove the DB2 products
specified in the response file. For more information, see the db2unins
command topic.

Unfortunately, your DB2 product cannot always be removed by using the Control
Panel - Add/Remove Programs facility or using the db2unins /p command or the
db2unins /u command. The following uninstallation option should ONLY be
attempted if the above method fails.

To forcefully remove all DB2 copies from your Windows system, run the db2unins
/f command. This command will perform a brute force uninstallation of ALL DB2
copies on the system. Everything except user data, such as DB2 databases, will be
forcefully deleted.

Related tasks:
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e “Uninstalling your DB2 product (Linux and UNIX)” in Quick Beginnings for DB2
Servers

¢ “Uninstalling a DB2 product using a response file (Windows)” in Installation and
Configuration Supplement

* “Changing the Default DB2 copy after installation (Windows)” in Administration
Guide: Implementation

Related reference:

* “db2swtch - Switch default DB2 copy command” in Command Reference

e “db2unins - Uninstall DB2 database product command” in Command Reference
* “DROP DATABASE command” in Command Reference

Uninstalling your DB2 products (Linux)

Removing DB2 products using the db2_deinstall or
doce_deinstall command (Linux)

This task provides steps for removing DB2 products or DB2 components using the
db2_deinstall command. The db2_deinstall command removes all DB2 products
from your system. The doce_deinstall command removes the DB2 Information
Center that is in the same install path as the doce_deinstall tool. This command is
only available on the Linux operating systems.

You cannot remove DB2 products using a native operating system utility, such as
rpm or SMIT.

Prerequisites:

Before you remove DB2 products from your system:

* Ensure that you have performed all steps outlined in Uninstalling your DB2
product.

* You must have root authority to remove DB2 products.
Procedure:

To remove ALL DB2 products from a specific path:
1. Log in as user with root authority.

2. Access the path where the DB2 products are located. To locate the path of the
DB2 product to remove, see

3. Run the db2_deinstall -a command from the DB2DIR/install directory or the
doce_deinstall -a command from the DB2DIR/doc/install directory, where
DB2DIR is the location that you specified when you installed your DB2
product.

Related tasks:
+ |“Applying fix packs” on page 71|

» “Listing DB2 products installed on your system (Linux and UNIX)” in Quick
Beginnings for DB2 Servers

* ["Removing DB2 instances (Linux)” on page 76|

* “Uninstalling your DB2 product (Linux and UNIX)” in Quick Beginnings for DB2
Servers
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Related reference:

* “db2_deinstall - Uninstall DB2 products or features command” in Command
Reference

e “db2_install - Install DB2 product command” in Command Reference
e “Multiple DB2 copies roadmap” in Administration Guide: Implementation

Stopping DB2 instances (Linux)

You must stop all DB2 instances associated with the DB2 copy you are uninstalling.
Instances associated with other DB2 copies should not be affected by uninstalling
the current copy.

Procedure:

To stop a DB2 instance:
1. Log in as a user with root authority.

2. To obtain a list of the names of all DB2 instances associated with your current
DB2 copy, enter the following command:

DB2DIR/bin/db2ilist

where DB2DIR is the location you specified during the DB2 Version 9
installation. The default installation path for Linux is /opt/ibm/db2/V9.1.

3. Log out.
4. Log back in as the owner of the instance you want to stop.
5. Run the start up script if it is not included in .profile.

. INSTHOME/sq11ib/db2profile (bash, Bourne, or Korn shells)
source INSTHOME/sql1ib/db2cshrc (C shell)

where INSTHOME is the home directory of the instance.

6. You might want to save the database manager configuration file, db2systm, the
db2nodes.cfg file, or user defined function or fenced stored procedure
applications in INSTHOME/sq11ib/function.

7. Stop the DB2 database manager by entering the db2stop force command.
8. Confirm that the instance is stopped by entering the db2 terminate command.
9. Repeat these steps for each instance.

Related reference:

» “db2ilist - List instances command” in Command Reference
* “db2stop - Stop DB2 command” in Command Reference

* “FORCE APPLICATION command” in Command Reference

Stopping the DB2 administration server (Linux)

You must stop the DB2 administration server (DAS) before you remove your DB2
product. You only need to perform this task if the DAS is associated with the DB2
copy you are uninstalling.

Procedure:

To stop the DB2 administration server:
1. Log in as the DB2 administration server owner.
2. Stop the DB2 administration server by entering the db2admin stop command.
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Related concepts:
* “DB2 Administration Server” in Administration Guide: Implementation

Related tasks:

* ["Removing DB2 products using the db2_deinstall or doce_deinstall command|
(Linux)” on page 74|

Related reference:

* “db2admin - DB2 administration server command” in Command Reference
Removing the DB2 administration server (Linux)

You must remove the DB2 administration server (DAS) before you remove your
DB2 product. You only need to remove the DB2 DAS if this is the last DB2 Version
9 copy that you're removing. Otherwise, you should run the dasupdt command
from the DB2 copy that you would like to have the DB2 DAS associated with.

Procedure:

To remove the DB2 administration server:

1. Log in as a user with root authority.

2. Stop the DB2 administration server.

3. Remove the DB2 administration server by entering the following command:
DB2DIR/instance/dasdrop

where DB2DIR is the location you specified during the DB2 Version 9
installation. The default installation path for Linux is /opt/ibm/db2/V9.1.

Related concepts:

* “DB2 Administration Server” in Administration Guide: Implementation

Related tasks:

* |“Removing DB2 products using the db2_deinstall or doce_deinstall command]|
(Linux)” on page 74|

+ [“Stopping the DB2 administration server (Linux)” on page 75|

Removing DB2 instances (Linux)

You can remove some or all of the DB2 instances on your system. Once an instance
is removed, you can use the DB2 databases owned by the instance if you catalog
them under another instance of the same release. Even though you remove the
instance, the databases are still intact and can be reused unless the database files
are expressly deleted.

Remove DB2 instances only if you are not planning to use your DB2 products, or if
you do not want to migrate existing instances to a later version of the DB2
product. Migration requires that both the new and old DB2 versions are still
installed. You cannot migrate an instance if the DB2 copy it is associated with has
been removed.

Procedure:

To remove an instance:
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1. Log in as a user with root authority.
2. Remove the instance by entering the following command:
DB2DIR/instance/db2idrop InstName

where DB2DIR is the location you specified during the DB2 Version 9
installation. The default installation path for Linux is /opt/ibm/db2/V9.1.

The db2idrop command removes the instance entry from the list of instances
and removes the INSTHOME/sq11ib directory, where INSTHOME is the home
directory of the instance and where InstName is the login name of the instance.
If you are storing any files in /sq11ib directory, these files will be removed by
this action. If you still need these files, you must make a copy of them before
dropping the instance.

3. Optional: As a user with root authority, remove the instance owner’s user ID
and group (if used only for that instance). Do not remove these if you are
planning to re-create the instance.

Remove the database files from the systems or drop the databases before
dropping the instance if you no longer need the databases. After dropping the
instance the database files remain intact.

This step is optional since the instance owner and the instance owner group
may be used for other purposes.

Related tasks:

* [“Removing DB2 products using the db2_deinstall or doce_deinstall command|
(Linux)” on page 74|

Related reference:

¢ “db2idrop - Remove instance command” in Command Reference
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Appendix E. DB2 Database technical information

Overview of the DB2 technical information

DB2 technical information is available through the following tools and methods:

¢ DB2 Information Center

Topics
Help for DB2 tools
Sample programs

Tutorials

* DB2 books
— PDF files (downloadable)
— PDEF files (from the DB2 PDF CD)
— printed books

e Command line help
— Command help
— Message help

e Sample programs

IBM periodically makes documentation updates available. If you access the online
version on the DB2 Information Center at ibm.com®, you do not need to install
documentation updates because this version is kept up-to-date by IBM. If you have
installed the DB2 Information Center, it is recommended that you install the
documentation updates. Documentation updates allow you to update the
information that you installed from the DB2 Information Center CD or downloaded
from Passport Advantage as new information becomes available.

Note: The DB2 Information Center topics are updated more frequently than either
the PDF or the hard-copy books. To get the most current information, install
the documentation updates as they become available, or refer to the DB2
Information Center at ibm.com.

You can access additional DB2 technical information such as technotes, white
papers, and Redbooks ' online at ibm.com. Access the DB2 Information

Management software library site at fhttp://www.ibm.com/software/data/sw-

Documentation feedback

We value your feedback on the DB2 documentation. If you have suggestions for
how we can improve the DB2 documentation, send an e-mail to
db2docs@ca.ibm.com. The DB2 documentation team reads all of your feedback, but
cannot respond to you directly. Provide specific examples wherever possible so
that we can better understand your concerns. If you are providing feedback on a
specific topic or help file, include the topic title and URL.

Do not use this e-mail address to contact DB2 Customer Support. If you have a

DB2 technical issue that the documentation does not resolve, contact your local
IBM service center for assistance.
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Related concepts:
* “Features of the DB2 Information Center” in Online DB2 Information Center
e “Sample files” in Samples Topics

Related tasks:

* “Invoking command help from the command line processor” in Command
Reference

* “Invoking message help from the command line processor” in Command
Reference

+ |“Updating the DB2 Information Center installed on your computer or intranet]
server” on page 85|

Related reference:

» |“DB2 technical library in hardcopy or PDF format” on page 80|

DB2 technical library in hardcopy or PDF format

The following tables describe the DB2 library available from the IBM Publications
Center at |Www.ibm.com/ shop /publications/ order] DB2 Version 9 manuals in PDF
format can be downloaded from [www.ibm.com/software/data/db2/udb/support/|
[manualsv9.html|

Although the tables identify books available in print, the books might not be
available in your country or region.

The information in these books is fundamental to all DB2 users; you will find this
information useful whether you are a programmer, a database administrator, or
someone who works with DB2 Connect or other DB2 products.

Table 4. DB2 technical information

Name Form Number Available in print
Administration Guide: SC10-4221 Yes
Implementation

Administration Guide: Planning ~ SC10-4223 Yes
Administrative API Reference SC10-4231 Yes
Administrative SQL Routines and SC10-4293 No
Views

Call Level Interface Guide and SC10-4224 Yes
Reference, Volume 1

Call Level Interface Guide and SC10-4225 Yes
Reference, Volume 2

Command Reference SC10-4226 No
Data Movement Utilities Guide =~ SC10-4227 Yes
and Reference

Data Recovery and High SC10-4228 Yes
Availability Guide and Reference

Developing ADO.NET and OLE ~ SC10-4230 Yes
DB Applications

Developing Embedded SQL SC10-4232 Yes
Applications
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Table 4. DB2 technical information (continued)

Name Form Number Available in print
Developing SQL and External SC10-4373 No

Routines

Developing Java Applications SC10-4233 Yes

Developing Perl and PHP SC10-4234 No

Applications

Getting Started with Database SC10-4252 Yes

Application Development

Getting started with DB2 GC10-4247 Yes

installation and administration on
Linux and Windows

Message Reference Volume 1 SC10-4238 No
Message Reference Volume 2 SC10-4239 No
Migration Guide GC10-4237 Yes
Net Search Extender SH12-6842 Yes

Administration and User’s Guide
Note: HTML for this

document is not installed from
the HTML documentation CD.

Performance Guide SC10-4222 Yes
Query Patroller Administration — GC10-4241 Yes
and User’s Guide

Quick Beginnings for DB2 GC10-4242 No
Clients

Quick Beginnings for DB2 GC10-4246 Yes
Servers

Spatial Extender and Geodetic SC18-9749 Yes

Data Management Feature User’s
Guide and Reference

SQL Guide SC10-4248 Yes
SQL Reference, Volume 1 SC10-4249 Yes
SQL Reference, Volume 2 SC10-4250 Yes
System Monitor Guide and SC10-4251 Yes
Reference

Troubleshooting Guide GC10-4240 No
Visual Explain Tutorial SC10-4319 No
What’s New SC10-4253 Yes
XML Extender Administration SC18-9750 Yes
and Programming

XML Guide SC10-4254 Yes
XQuery Reference SC18-9796 Yes

Table 5. DB2 Connect-specific technical information

Name Form Number Available in print
DB2 Connect User’s Guide SC10-4229 Yes
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Table 5. DB2 Connect-specific technical information (continued)

Name Form Number Available in print
Quick Beginnings for DB2 GC10-4244 Yes

Connect Personal Edition

Quick Beginnings for DB2 GC10-4243 Yes

Connect Servers

Table 6. WebSphere Information Integration technical information

Name Form Number Available in print

WebSphere Information SC19-1020 Yes
Integration: Administration Guide
for Federated Systems

WebSphere Information SC19-1018 Yes
Integration: ASNCLP Program

Reference for Replication and

Event Publishing

WebSphere Information SC19-1034 No
Integration: Configuration Guide
for Federated Data Sources

WebSphere Information SC19-1030 Yes
Integration: SQL Replication
Guide and Reference

Note: The DB2 Release Notes provide additional information specific to your
product’s release and fix pack level. For more information, see the related
links.

Related concepts:

* [“Overview of the DB2 technical information” on page 79|

e “About the Release Notes” in Release notes

Related tasks:
+ [“Ordering printed DB2 books” on page 82}

Ordering printed DB2 books

If you require printed DB2 books, you can buy them online in many but not all
countries or regions. You can always order printed DB2 books from your local IBM
representative. Keep in mind that some softcopy books on the DB2 PDF
Documentation CD are unavailable in print. For example, neither volume of the DB2
Message Reference is available as a printed book.

Printed versions of many of the DB2 books available on the DB2 PDF
Documentation CD can be ordered for a fee from IBM. Depending on where you
are placing your order from, you may be able to order books online, from the IBM
Publications Center. If online ordering is not available in your country or region,
you can always order printed DB2 books from your local IBM representative. Note
that not all books on the DB2 PDF Documentation CD are available in print.
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Note: The most up-to-date and complete DB2 documentation is maintained in the
DB2 Information Center at fhttp:/ /publib.boulder.ibm.com/infocenter /|
db2help /

Procedure:

To order printed DB2 books:

* To find out whether you can order printed DB2 books online in your country or
region, check the IBM Publications Center at ttp://www.ibm.com/shop /|
[publications/order] You must select a country, region, or language to access
publication ordering information and then follow the ordering instructions for
your location.

* To order printed DB2 books from your local IBM representative:

— Locate the contact information for your local representative from one of the
following Web sites:

- The IBM directory of world wide contacts at [www.ibm.com /planetwide|

- The IBM Publications Web site at |http:/ /www.ibm.com/shop /|
|publications / order| You will need to select your country, region, or
language to the access appropriate publications home page for your
location. From this page, follow the "About this site” link.

— When you call, specify that you want to order a DB2 publication.

— Provide your representative with the titles and form numbers of the books
that you want to order.

Related concepts:

+ [“Overview of the DB2 technical information” on page 79|

Related reference:

* ["DB2 technical library in hardcopy or PDF format” on page 80|

Displaying SQL state help from the command line processor

DB2 returns an SQLSTATE value for conditions that could be the result of an SQL
statement. SQLSTATE help explains the meanings of SQL states and SQL state class
codes.

Procedure:

To invoke SQL state help, open the command line processor and enter:
? sqlstate or ? class code

where sglstate represents a valid five-digit SQL state and class code represents the
first two digits of the SQL state.

For example, ? 08003 displays help for the 08003 SQL state, and ? 08 displays help
for the 08 class code.

Related tasks:

* “Invoking command help from the command line processor” in Command
Reference

* “Invoking message help from the command line processor” in Command
Reference
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Accessing different versions of the DB2 Information Center

For DB2 Version 9 topics, the DB2 Information Center URL is
[publib.boulder.ibm.com /infocenter /db2luw /v9 /|

For DB2 Version 8 topics, go to the Version 8 Information Center URL at:
[http:/ /publib.boulder.ibm.com/infocenter /db2luw /v8/|

Related tasks:

e “Setting up access to DB2 contextual help and documentation” in Administration
Guide: Implementation

Displaying topics in your preferred language in the DB2 Information
Center

The DB2 Information Center attempts to display topics in the language specified in
your browser preferences. If a topic has not been translated into your preferred
language, the DB2 Information Center displays the topic in English.

Procedure:

To display topics in your preferred language in the Internet Explorer browser:

1. In Internet Explorer, click the Tools —> Internet Options —> Languages...
button. The Language Preferences window opens.

2. Ensure your preferred language is specified as the first entry in the list of
languages.

* To add a new language to the list, click the Add... button.

Note: Adding a language does not guarantee that the computer has the fonts
required to display the topics in the preferred language.

* To move a language to the top of the list, select the language and click the
Move Up button until the language is first in the list of languages.

3. Clear the browser cache and then refresh the page to display the DB2
Information Center in your preferred language.

To display topics in your preferred language in a Firefox or Mozilla browser:

1. Select the Tools —> Options —> Languages button. The Languages panel is
displayed in the Preferences window.
2. Ensure your preferred language is specified as the first entry in the list of
languages.
* To add a new language to the list, click the Add... button to select a language
from the Add Languages window.

* To move a language to the top of the list, select the language and click the
Move Up button until the language is first in the list of languages.

3. Clear the browser cache and then refresh the page to display the DB2
Information Center in your preferred language.

On some browser and operating system combinations, you might have to also

change the regional settings of your operating system to the locale and language of
your choice.
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Related concepts:

* [“Overview of the DB2 technical information” on page 79|

Updating the DB2 Information Center installed on your computer or

intranet server

If you have a locally-installed DB2 Information Center, updated topics can be
available for download. The 'Last updated' value found at the bottom of most
topics indicates the current level for that topic.

To determine if there is an update available for the entire DB2 Information Center,
look for the 'Last updated’ value on the Information Center home page. Compare
the value in your [locally installed home page|to the date of the most recent
downloadable update at Ihttp: / /www.ibm.com/software/data/db2/udb/support/ |
You can then update your locally-installed Information Center if a

more recent downloadable update is available.

Updating your locally-installed DB2 Information Center requires that you:

1.

Stop the DB2 Information Center on your computer, and restart the Information
Center in stand-alone mode. Running the Information Center in stand-alone
mode prevents other users on your network from accessing the Information
Center, and allows you to download and apply updates.

Use the Update feature to determine if update packages are available from
IBM.

Note: Updates are also available on CD. For details on how to configure your
Information Center to install updates from CD, see the related links.

If update packages are available, use the Update feature to download the

packages. (The Update feature is only available in stand-alone mode.)

Stop the stand-alone Information Center, and restart the DB2 Information
Center service on your computer.

Procedure:

To update the DB2 Information Center installed on your computer or intranet
server:

1.

Stop the DB2 Information Center service.

* On Windows, click Start » Control Panel » Administrative Tools » Services.
Then right-click on DB2 Information Center service and select Stop.

* On Linux, enter the following command:
/etc/init.d/db2icdv9 stop

2. Start the Information Center in stand-alone mode.

¢ On Windows:
a. Open a command window.

b. Navigate to the path where the Information Center is installed. By
default, the DB2 Information Center is installed in the C:\Program
Files\IBM\DB2 Information Center\Version 9 directory.

C. Run the help_start.bat file using the fully qualified path for the DB2
Information Center:

<DB2 Information Center dir>\doc\bin\help start.bat
* On Linux:

Appendix E. DB2 Database technical information 85


http://www.ibm.com/software/data/db2/udb/support/icupdate.html
http://www.ibm.com/software/data/db2/udb/support/icupdate.html

a. Navigate to the path where the Information Center is installed. By
default, the DB2 Information Center is installed in the /opt/ibm/db2ic/V9
directory.

b. Run the help_start script using the fully qualified path for the DB2
Information Center:

<DB2 Information Center dir>/doc/bin/help_start

The systems default Web browser launches to display the stand-alone
Information Center.

3. Click the Update button (3). On the right hand panel of the Information
Center, click Find Updates. A list of updates for existing documentation
displays.

4. To initiate the download process, check the selections you want to download,
then click Install Updates.

5. After the download and installation process has completed, click Finish.

6. Stop the stand-alone Information Center.

¢ On Windows, run the help_end.bat file using the fully qualified path for the
DB2 Information Center:

<DB2 Information Center dir>\doc\bin\help end.bat

Note: The help_end batch file contains the commands required to safely
terminate the processes that were started with the help_start batch file.
Do not use Ctr1-C or any other method to terminate help_start.bat.

* On Linux, run the help_end script using the fully qualified path for the DB2
Information Center:

<DB2 Information Center dir>/doc/bin/help_end

Note: The help_end script contains the commands required to safely
terminate the processes that were started with the help_start script. Do
not use any other method to terminate the help_start script.

7. Restart the DB2 Information Center service.

* On Windows, click Start » Control Panel » Administrative Tools » Services.
Then right-click on DB2 Information Center service and select Start.

* On Linux, enter the following command:
/etc/init.d/db2icdv9 start

The updated DB2 Information Center displays the new and updated topics.

Related concepts:
* “DB2 Information Center installation options” in Quick Beginnings for DB2 Servers

Related tasks:

* “Installing the DB2 Information Center using the DB2 Setup wizard (Linux)” in
Quick Beginnings for DB2 Servers

* “Installing the DB2 Information Center using the DB2 Setup wizard (Windows)”
in Quick Beginnings for DB2 Servers
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DB2 tutorials

The DB2 tutorials help you learn about various aspects of DB2 products. Lessons
provide step-by-step instructions.

Before you begin:

You can view the XHTML version of the tutorial from the Information Center at
[http: / /publib.boulder.ibm.com/infocenter /db2help /|

Some lessons use sample data or code. See the tutorial for a description of any
prerequisites for its specific tasks.

DB2 tutorials:

To view the tutorial, click on the title.

Native XML data store
Set up a DB2 database to store XML data and to perform basic operations
with the native XML data store.

Visual Explain Tutorial
Analyze, optimize, and tune SQL statements for better performance using
Visual Explain.

Related concepts:
* “Visual Explain overview” in Administration Guide: Implementation

DB2 troubleshooting information

A wide variety of troubleshooting and problem determination information is
available to assist you in using DB2 products.

DB2 documentation
Troubleshooting information can be found in the DB2 Troubleshooting
Guide or the Support and Troubleshooting section of the DB2 Information
Center. There you will find information on how to isolate and identify
problems using DB2 diagnostic tools and utilities, solutions to some of the
most common problems, and other advice on how to solve problems you
might encounter with your DB2 products.

DB2 Technical Support Web site
Refer to the DB2 Technical Support Web site if you are experiencing
problems and want help finding possible causes and solutions. The
Technical Support site has links to the latest DB2 publications, TechNotes,
Authorized Program Analysis Reports (APARs or bug fixes), fix packs, and
other resources. You can search through this knowledge base to find
possible solutions to your problems.

Access the DB2 Technical Support Web site at http:/ /www.ibm.com /|
lsoftware /data/db2/udb/support.html|

Related concepts:
¢ “Introduction to problem determination” in Troubleshooting Guide

* [“Overview of the DB2 technical information” on page 79|
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Terms and Conditions

Permissions for the use of these publications is granted subject to the following
terms and conditions.

Personal use: You may reproduce these Publications for your personal, non
commercial use provided that all proprietary notices are preserved. You may not
distribute, display or make derivative work of these Publications, or any portion
thereof, without the express consent of IBM.

Commercial use: You may reproduce, distribute and display these Publications
solely within your enterprise provided that all proprietary notices are preserved.
You may not make derivative works of these Publications, or reproduce, distribute
or display these Publications or any portion thereof outside your enterprise,
without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the Publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the Publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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Appendix F. Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country/region or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country/region where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions; therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information that has been exchanged, should contact:

IBM Canada Limited
Office of the Lab Director
8200 Warden Avenue
Markham, Ontario

L6G 1C7

CANADA

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems, and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements, or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility, or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information may contain examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious, and any similarity to the names and addresses used by an actual
business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information may contain sample application programs, in source language,
which illustrate programming techniques on various operating platforms. You may
copy, modify, and distribute these sample programs in any form without payment
to IBM for the purposes of developing, using, marketing, or distributing
application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as follows:
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© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Trademarks

Company, product, or service names identified in the documents of the DB2
Version 9 documentation library may be trademarks or service marks of
International Business Machines Corporation or other companies. Information on
the trademarks of IBM Corporation in the United States, other countries, or both is
located at |http:/ /www.ibm.com/legal / copytrade.shtml}

The following terms are trademarks or registered trademarks of other companies
and have been used in at least one of the documents in the DB2 documentation
library:

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Intel, I[tanium, Pentium, and Xeon are trademarks of Intel Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, or service names may be trademarks or service marks of
others.
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Contacting IBM

To contact IBM in your country or region, check the IBM Directory of Worldwide
Contacts at [http://www.ibm.com /planetwide|

To learn more about DB2 products, go to
[http:/ /www.ibm.com /software /data/db2/|
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